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About this Manual
This manual describes how to configure the system environment and install the Interstage Business
Process Manager (Interstage BPM) Server and Console.
Note that the Interstage BPM Tenant Management Console is automatically deployed when you
deploy Interstage BPM Console.

Intended Audience
This manual is intended for Interstage BPM Super Users, who are administrators managing Interstage
BPM Server. It assumes that the reader has a working knowledge of
• Operating system administration
• Application server administration
• Database administration
• Directory Service administration

This Manual Contains
Here is a list of what is in this manual:

DescriptionTitleChapter

Description of the typical system
configurations for the installation
of Interstage BPM Server.

System Configurations for Interstage
BPM Server

1

Description of the typical system
configurations for the installation
of Interstage BPM Console.

System Configurations for Interstage
BPM Console

2

Description of the minimum
system requirements by
platform.

System Requirements for Interstage
BPM Server and Console

3

An overview of using the new
integrated Deployment Tool

Overview of Integrated Deployment of
Interstage BPM Server and Console

4

Instructions for preparing
external systems like the
database or the application
server.

Preparing for Installation and
Deployment of Interstage BPM Server
and Console

5

Instructions for performing
installation of Interstage BPM
Server and Console.

Installing and Deploying Interstage BPM
Server and Console

6

Instructions to run the Wizard for
integrating Interstage Analytics
with Console.

Configuring Interstage BPM Console to
work with Interstage Analytics

7

Instructions for setting up your
Directory Service.

Setting Up a Directory Service8
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DescriptionTitleChapter

Instructions for removing an
instance of Interstage BPM
Server and Console from the
application server and for
uninstalling Interstage BPM

Undeploying and Uninstalling Interstage
BPM Server and Console

9

Instructions for performing an
upgrade.

Upgrading Interstage BPM from
Previous Versions

10

Instructions for security
implementation on Interstage
BPM.

SecurityAppendix A

Instructions for using the Silent
Mode installation feature of
Interstage BPM.

Silent Mode InstallationAppendix B

Instructions for running the
Interstage BPM Deployment
Tool in Silent Mode.

Silent Mode Deployment and
Undeployment

Appendix C

Instructions for uninstalling
Interstage BPM in Silent Mode.

Silent Mode UninstallationAppendix D

Instructions for installing
Interstage BPM Server in Solaris
containers that run on the same
physical computer.

Running Interstage Business Process
Manager in Solaris Containers

Appendix E

Instructions for setting up a
cluster of Interstage BPM
Servers.

Clustering, Load Balancing, and
Failover

Appendix F

Instructions to enable NTLM
Authentication Protocol for
Interstage BPM Console

Enabling NTLM Authentication Protocol
for Interstage BPM Console

Appendix G

Information to help you
troubleshoot problems
associated with using Interstage
BPM.

TroubleshootingAppendix H

Screenshots of the products that appear in this manual are approximations only. What you see when
using the product may differ in appearance due to platform or product version differences.

Typographical Conventions
The following conventions are used throughout this manual:

MeaningExample

Text, which you are required to type at a
command line, is identified by Courier font.

command

Text, which is visible in the user interface, is bold.screen text

Interstage BPM Server and Console Installation Guide (WebLogic Server) 9

About this Manual



MeaningExample

Reference material is in italics.Reference

A command parameter is identified by Courier
font.

Parameter

Other References
The following references for Interstage Business Process Manager are also available:
• Release Notes

Contains an overview of Interstage Business Process Manager, installation tips, and late-breaking
information that could not make it into the manuals.

• Interstage Business Process Manager Server and Console Installation Guide
Describes software and hardware requirements, installation procedure for Interstage Business
Process Manager Server and Console

• Interstage Business Process Manager Server Administration Guide
Explains how to configure and administrate Interstage Business Process Manager Server. This
guide also describes the configuration parameters of the Interstage BPM Server.

• Interstage Business Process Manager Developer's Guide
Describes how to use the Interstage Business Process Manager API to customize and extend
Interstage BPM to fit the unique needs of your organization.

• Interstage Business Process Manager Studio User's Guide
Explains how to model processes using the Interstage Business Process Manager Studio.

• Interstage Business Process Manager Tenant Management Console Online Help
Explains how to use the Interstage Business Process Manager Tenant Management Console
user interface.

• Interstage Business Process Manager Console Online Help
Explains how to use the Interstage Business Process Manager Console user interface.

• API Javadoc Documentation
This HTML documentation provides the API and syntax of the packages, interfaces and classes
for developing custom applications or embedding Interstage Business Process Manager into
other products.

Abbreviations
The products described in this manual are abbreviated as follows:
• "BEA WebLogic Server" , "Oracle WebLogic Server" is referred to as "WebLogic Application

Server" and abbreviated as "WebLogic".
• "Interstage Business Process Manager" is abbreviated as "Interstage BPM".
• "Microsoft® Windows Server® 2003" is abbreviated as "Windows Server® 2003".
• "Oracle Solaris" might be described as "Solaris", "Solaris Operating System", and "Solaris OS"

in this document.
• "Microsoft® SQL Server 2005 Standard Edition", and "Microsoft® SQL Server 2005 Enterprise

Edition", "Microsoft® SQL Server 2008 Standard Edition", and "Microsoft® SQL Server 2008
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Enterprise Edition" are abbreviated as "Microsoft® SQL Server","Microsoft SQL Server", or "SQL
Server".

• "Oracle 10g R2 Standard Edition", "Oracle 10g R2 Standard Edition One", "Oracle 10g R2
Enterprise Edition", "Oracle 11g Standard Edition", "Oracle 11g Standard Edition One", "Oracle
11g Enterprise Edition" are abbreviated as "Oracle".
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1 System Configurations for Interstage BPM Server
Interstage Business Process Manager (Interstage BPM) is a server-based workflow engine with APIs
(Application Programming Interfaces) for workflow application development.
The Interstage BPM Server runs on an application server providing load balancing and failover
capabilities, and it operates with a database, which persistently stores and maintains all process
information.
A user and group store is required to manage Interstage BPM user accounts and to expand a group
into a list of users. Depending on your choices when deploying the server, users are managed either
in Interstage BPM's local user store or in a Directory Service. Groups can be managed in Interstage
BPM's local group store, in a Directory Service or in both systems.
The Interstage BPM Server is shipped with a Deployment Tool, which is used to
• Configure the database, the application server and the Interstage BPM Server
• Deploy the Interstage BPM Server and Console to the application server
The system configurations described in the next sections are typically used. The decision of the
configuration to be used depends on the desired performance of the employed systems.

1.1 Minimum Configuration: All Systems on the same
Computer
You can install the Interstage BPM Deployment Tool, the Interstage BPM Server, the database, and,
if you plan to use a remote user store, the Directory Service on the same computer.

Figure 1: All systems on the same computer

For details about the architecture of Interstage BPM, refer to the Interstage Business ProcessManager
Server Administration Guide.

Interstage BPM Server and Console Installation Guide (WebLogic Server) 12

1: System Configurations for Interstage BPM Server



1.2 Database on Remote Computer
The following figure shows a configuration where the Interstage BPM Server and the database are
installed on separate computers.

Figure 2: Database on Remote Computer

To set up this configuration, you install the Interstage BPM Server software on the computer hosting
the database and use the Deployment Tool to configure the database.
Next, you copy the database setup script from the Interstage BPM Server-computer to the database
server computer. The Interstage BPM Deployment Tool can then be run from that computer to
configure the application server and deploying the Interstage BPM Server to the application server.
In the configuration shown above, the Directory Service is also installed on a remote computer.
However, this has no impact on the Interstage BPM installation procedure.
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2 System Configurations for Interstage BPM Console
The Interstage BPM Console is the Client that connects to the Interstage BPM Server.
The Interstage BPM Console must run on the same application server on the same machine as the
Interstage BPM Server to which it connects.
The system configurations described in the next sections are typically used. The decision of the
configuration to be used depends on the desired performance of the employed systems.

2.1 Minimum Configuration: All Systems on the same
Computer
Interstage BPM Server and Console is always deployed together on the same computer.

Figure 3: All systems on the same computer

For details about the architecture of the Interstage BPM Server, refer to the Interstage Business
Process Manager Server Administration Guide .
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3 System Requirements for Interstage BPM Server
and Console

3.1 Hardware Requirements for Interstage BPM Server and
Console

Machine and Processor

ProcessorMachineOperating
System

Minimum: Intel® Pentium III processor,
1 GHz, 1 CPU or greater
Recommended: Intel® Pentium III
processor, 2 GHz, 2 CPU or greater

Fujitsu PRIMERGY or other Intel
Architecture servers

Windows

Minimum: Ultra SPARC or SPARC64 V
(kernel arch: sun4u/sun4us/sun4d) 1
GHz, 1 CPU or greater
Recommended: SPARC 1.2GHz, 2CPU
or greater

Fujitsu PRIMEPOWER or other Solaris
servers

Solaris

Minimum: Intel® Pentium III processor,
1 GHz, 1 CPU or greater
Recommended: Intel® Pentium III
processor, 2 GHz, 2 CPU or greater

Fujitsu PRIMERGY or other Intel
Architecture server

Linux

Memory
Minimum: 1 GB
Recommended for Server: 2 GB or more
Recommended for Console: 4 GB or more

Hard Drive
Recommended for Server: 8 GB of free space during runtime (at least 1 GB must be available in the
/tmp directory)
(Please refer the calculation method below)
Interstage BPM installation: 300 MB
Log file space: Depends on the number of active users. As a rule of thumb, with the default log level,
calculate 5 KB for each user logging in. For example, if 1000 users log in per day, the log file increases
by 5 MB per day.
Database server installation: Please refer to the product documentation.
Database space:
As a rule of thumb, 1000 instances of a process definition with 10 nodes require about 5 MB. During
Interstage BPM runtime, the processing of work items, history entries in the database, etc., require
additional space besides the initial database size. This additional space depends on 1) the number
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of process instances 2) the number of active nodes 3) the number of users who are assigned to work
items.
For example, if you have 1000 instances of a process with 10 nodes, 50% of the nodes require
parallel processing (e.g. OR nodes), 10 users are accessing the process instances, you need the
following disk space at runtime:
1500 active nodes multiplied with 10 users: 15,000 KB or 15 MB

3.2 Minimum Software Requirements for Server and Console
For software requirements for the server, refer to the Interstage BPM Server Release Notes.
For software requirements for the Console, refer to the Interstage BPM Console Release Notes.

3.2.1 Preparation for Installing Interstage BPM on Linux Environments
If using Linux, before installation ensure the following packages of Red Hat Enterprise Linux are
available.
To check whether a particular package is installed, use the following command:

rpm -q <package-name>

(Note that (i686) and (x86_64) below denote the respective package's architecture.)
Packages for Red Hat Enterprise Linux 5 (32 bit and 64 bit):
• libXp (i686)

Packages for Red Hat Enterprise Linux 6 (32 bit):
• glibc-devel (i686)

• glibc-headers (i686)

• kernel-headers (i686)

• libXp (i686)

Packages for Red Hat Enterprise Linux 6 (64 bit):
• glibc (i686)

• glibc-devel (i686)

• glibc-headers (x86_64)

• kernel-headers (x86_64)

• libICE (i686)

• libSM (i686)

• libX11 (i686)

• libXau (i686)

• libXext (i686)

• libXi (i686)

• libXp (i686)

• libXt (i686)

• libXtst (i686)

• libuuid(i686)

• libxcb (i686)
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• nss-softokn-freebl (i686)

In case any package is not installed, download it from your Red Hat Enterprise Linux CD or the Red
Hat Network website, and install it using the following command:

rpm -i <package-name>

If you plan to perform GUI-based installation and deployment of Interstage BPM on Linux,
you need to install X Window System on your Linux machine. X Window System is not
installed by default on Red Hat Enterprise Linux 6. For this, ensure that the following
packages are installed:

Note:

• X Window System
• Desktop
• Legacy X Window System compatibility
• General Purpose Desktop

3.3 Hardware Requirements for Browser

Machine
Fujitsu DESKPOWER, ESPRIMO, SCENIC, SCALEO, CELCIUS, Lifebook, AMILO, PRIMERGY or
other Windows PC / Intel Architecture servers

Processor
Pentium III 500 MHz or greater

Memory
Minimum: 512 MB, Recommended: 2 GB or more

3.4 MinimumSoftware Requirements forWebBrowser Clients
For software requirements for the client machines connecting to the Console remotely, refer to the
Release Notes.
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4 Overview of Integrated Deployment of Interstage
BPM Server and Console
You can deploy Interstage BPM Server and Console together using the integrated Deployment Tool.

When you deploy Interstage BPM Console, Interstage BPM Tenant Management Console
is automatically deployed as well.

Note:

If you are upgrading from a previous version of Interstage BPM, refer Upgrading Interstage
BPM from Previous Versions on page 71.

Note:
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5 Preparing for Installation and Deployment of
Interstage BPM Server and Console
This chapter explains how to set up your environment before installation and deployment of Interstage
BPM.

5.1 Database Server Preparation
This section provides instructions in configuring your database software for use by Interstage BPM.
You must create a new database instance for Interstage BPM. When deploying the Interstage BPM
Server and Console, you will specify this instance. These instructions use the default database
instance for the purpose of providing an example.

5.1.1 Configuring Microsoft® SQL Server
Microsoft® SQL Server 2005 or Microsoft® SQL Server 2008 can be used as the database with
Interstage BPM.
Prerequisites: Microsoft SQL Server is installed. If you want to user Microsoft SQL Server as
database for deploying Interstage BPM Server and Console in non-windows environments, ensure
that Microsoft SQL Server is used as remote database.
To configure Microsoft SQL Server:
1. Change SQL Server Authentication

a) Interstage BPM only supports SQL Server Authentication. To enable this, install Microsoft®
SQL Server in Mixed Mode.

If Microsoft® SQL Server is already installed, you may have to run a configuration program
such asSQLServer ConfigurationManager if the default selection from the prior installation
enabled Named Pipes. Run the SQL Server Configuration Manager and add TCP/IP.
However, do not disable Named Pipes. Both must be selected.

Note:

2. Configure the network for SQL Server
a) Confirm that TCP/IP is selected under Network Operations.
b) Determine the port number of the Microsoft® SQL Server instance that Interstage BPM will

connect to. To do so:
1. Select Start > Programs > Microsoft SQL Server 2005/2008 > Configuration Tools >

SQL Server Configuration Manager.
2. Navigate to SQL Server Network Configuration > Protocols for <MSSQLInstance>.

For the default instance, the value of <MSSQLInstance> is MSSQLSERVER.
3. Confirm that TCP/IP is enabled. Then, go to the TCP/IP properties and click the IP

Addresses tab. The IPAll section displays the TCP port and TCP Dynamic Ports
parameters.

4. If you are using the default Microsoft® SQL Server instance, note down the value of TCP
Port. If you are using a named instance, note down the value of the TCP Dynamic Ports.
You will need to specify the port number later when deploying the Interstage BPM Server.

3. Confirm Collation settings.
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The default Collation settings at the time of installing Microsoft SQL are usually correct. However,
if you receive a collation error when deploying, you need to configure these settings.
a) Use the following query to make the collation of your database case-insensitive:

ALTER DATABASE teamflowdb COLLATE <collationName>

where <collationName> is the name of the collation, example, Latin1_General_CI_AS.
Ensure this is case-insensitive, that is, it contains the 'CI' characters.

If you have changed the CaseSensitivity parameter to CS for the server level collation, you
cannot create database via the Deployment Tool. In such a case, you need to first create
Interstage BPM database using the database creation script, and change the database
collation to CaseSensitive. Then you need to select the Use existing database option in
the Database Settings screen of the Deployment Tool.

Note:

4. Install the SQL Server Driver for JDBC.
You need to copy the required Microsoft SQL Server JDBC driver files from Microsoft SQL Server
WebSite to the application server computer. You will need to specify the driver location later when
deploying the Interstage BPM Server. For the exact version of the JDBC driver supported, refer
the Release Notes. If you are running your database on a remote computer, you need to copy
the required jdbc driver files to the application server computer.
In case of UNIX environments you need to confirm the JDBC driver jar's permission. The
permission must be '666'(ugo=rw).

5.1.2 Configuring Oracle
Prerequisite: Oracle is installed.

To configure Oracle for Interstage BPM:
1. Set the ORACLE_HOME environment variable to the installation directory of the database server

you are deploying on.
• Example on Oracle 10g:

ORACLE_HOME=/opt/oracle/app/oracle/product/10.2.0/db_1

• Example on Oracle 11g:
ORACLE_HOME=/opt/Oracle/Oracle11gR2/product/11.2.0/dbhome_1

You can either set the environment variable in your ~/.profile file or in the shell before starting the
Deployment Tool.

If you set the environment variable in the shell, run the set -a command so that the
environment variable is set for all subshells created from the parent shell.

Note:

2. Create a new database instance for Interstage BPM.
When deploying the Interstage BPM Server, you will specify this instance. The default database
instance for Oracle is ORCL.
Make sure that the database instance is created with the following character sets:
• AL32UTF8 as the database character set
• AL16UTF16 as the national character set
These settings are required to support Unicode UTF-16 characters.

3. Make sure that a TCP/IP version of Oracle's SQL*Net is installed.
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The Oracle JDBC driver requires a TCP/IP version of Oracle's SQL*Net. This is the default for a
standard installation.

If you need to uninstall Oracle or require recovery from a failed installation, contact Oracle
Technical Support for instructions before reinstalling.

Note:

4. Install the Oracle Driver for JDBC.
a) You need to copy the required Oracle JDBC driver files from Oracle WebSite to the application

server computer. You will need to specify the driver location later when deploying the Interstage
BPM Server. For the exact version of the JDBC driver supported, refer the Release Notes. If
you are running your database on a remote computer, you need to copy the required jdbc
driver files to the application server computer.

b) In UNIX environments, confirm the JDBC driver jar's permission. The permission must be
'666'(ugo=rw).

5. Change permissions in case of UNIX environments.
a) You must have execute permissions for the sqlplus file located in the <ORACLE_HOME>/bin

directory.
b) You must have write permissions for the directory in which the Interstage BPM database will

reside.

5.1.3 Starting the Database Server
Since configuration information must be written to the database during deployment, ensure that the
database server is running prior to deploying Interstage BPM Server. Start the database server
according to the documentation provided with your database server.

5.2 Application Server Preparation

5.2.1 How to configure aWebLogic Domain for the Interstage BPMServer
Prerequisite: You have installed the WebLogic Application Server.

Configuring a WebLogic Domain for the Interstage BPM Server
To create a WebLogic domain for Interstage BPM:
1. Start the WebLogic Domain Configuration Wizard as follows:

• On Windows, do either of the following:
• Select Start > All Programs > Oracle WebLogic > Weblogic Server 11g R1 > Tools >

Configuration Wizard.
• Run the config.cmd script located in the <MW_HOME>/wlserver_10.3/common/bin directory.

• On UNIX, run the config.sh script located in the <MW_HOME>/common/bin directory.
The Welcome page appears.

2. Make sure that the Create a new WebLogic domain checkbox is selected. Then, click Next.
The Select Domain Source page appears.
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3. Make sure that the Generate a domain configured automatically to support the following
products option and Basic Weblogic Server Domain - 10.3.2.0[wlserver_10.3] check box are
selected. Then, click Next.
The Specify Domain Name and Location page appears.

4. In the Domain location field, specify a configuration location. By default,
<MW_HOME>/user_projects/domains is used. In the Domain name field, specify a name for
your name. By default, base_domain is used. Then, click Next.

You do not have to accept the default domain name or domain location. You can choose
any name or location for your new domain. You will be asked for this user name and
password when deploying the Interstage BPM Server. This user is also known as your
WebLogic AdminUser.

Note:

The Configure Administrator Username and Password page appears.

5. Enter a user name and password. This user becomes the initial administrative user for the domain.
Then, click Next.
The Configure Server Start Mode and JDK page appears.

6. Select the appropriate Java SDK and click Next:
• On Windows, select the SUN SDK.
• On Solaris, select the SUN SDK.
The Select Optional Configuration page appears.

7. Do not select any of the checkboxes, and click Next.
The Configuration Summary page appears, showing the summary of the domain to be created.

8. Click Create.
The Creating Domain page appears and will indicate the progress of your domain creation.

9. When your domain creation is completed, check the Start Admin Server checkbox and click
Done.

When your Admin Server appears, you are ready to deploy the Interstage BPM.

5.2.2 Configuring WebLogic Domain Security for Interstage BPM Server

Special WebLogic Server Configurations to Enable Web Service Operations
The instructions in this topic are needed if you want to perform the following operations:
• Download or upload process definitions from remote Interstage BPM Servers. This operation is

used by Interstage BPM Studio also.
• Run remote subprocesses using SWAP (Simple Workflow Access Protocol) or ASAP

(Asynchronous Service Access Protocol).
• Call Web Services from process definitions without specifying an endpoint URL.

The following steps are not automatically executed by the Deployment Tool. These steps
are necessary to do manually if you want to use above functionality.

Note:
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To enable the listed Web Services Operations :
1. Stop the WebLogic Administration Server and Interstage BPM Server in which the Console is

running.
2. Add the following tag block as the last block in the

<MW_HOME>/user_projects/domains/base_domain/config/config.xml file on WebLogic
10.3.2, for the WebLogic Server Domain in which the Interstage BPM Console is deployed:
<enforce-valid-basic-auth-credentials>false</enforce-valid-basic-auth-credentials>

For example:

...
<enforce-valid-basic-auth-credentials>false</enforce-valid-basic-auth-credentials>

</security-configuration>

3. Save the changes you have made to this file.
4. Start the WebLogic Administration Server and Interstage BPM Server in which the Console is

configured.

The WebLogic configuration change described in these instructions effectively "turns off" WebLogic
authentication. For Interstage BPM purposes, WebLogic authentication is unnecessary because the
Console authenticates its users.

Configuring WebLogic's Embedded LDAP Server
WebLogic Application Server comes with an embedded LDAP Server. You need to configure
WebLogic's embedded LDAP Server if any of the following applies:
• You are using Interstage BPM Studio.
• You want to run remote subprocesses using SWAP (Simple Workflow Access Protocol) or ASAP

(Asynchronous Service Access Protocol).
• You want to call Web Services from process definitions without specifying an endpoint URL.
To configure the embedded LDAP Server, do one of the following:
• Configure the Directory Service that you are using as an authentication provider for the embedded

LDAP Server.
• Add the required users manually to the embedded LDAP Server.

If you want to run remote subprocesses, you need to add the owner of the parent process definition.
If you want to call Interstage BPM Web Services from process definitions without specifying an
endpoint URL, you need to add the Interstage BPM Administrator account. This is the account
that you defined during the deployment of Interstage BPM Server.

For detailed instructions on how to configure the embedded LDAP Server, refer to the WebLogic
Application Server documentation.

5.2.3 Starting WebLogic Administration Server
Before deploying Interstage BPM Server or Console, make sure that the WebLogic Administration
Server is running.
To start the WebLogic Administration Server:
1. Run the startup script located in:

<MW_HOME>/user_projects/domains/<Domain Name>/bin
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ScriptOperating System

startWebLogic.cmdWindows

startWebLogic.shUNIX

2. On Windows, for WebLogic 10.3.2, you can start the server by selecting Start > Programs >
Oracle WebLogic > User Projects > <Domain Name> > Start Admin Server for WebLogic
Server Domain.

Upon successful initialization of the WebLogic Administration Server, the following message appears
near the end of the WebLogic Console Window:
<Server started in RUNNING mode>

If you run the WebLogic Administration Server as a Windows service, wait awhile after the
Windows service says that the service is running, because it takes longer for WebLogic
Administration Server to start.

Note:

5.3 Directory Server Preparation
If you use local user management system, you do not need to do this step. Local user management
system is user management function for Interstage BPM that is provided by Interstage BPM. In the
Local user management system, all of the users for Interstage BPM are created in the database.
If you want to use external directory service to manage Interstage BPM users, you need to register
LDAP Access for users before deploying Interstage BPM Server and Console. How to setup external
directory service is described in Setting Up a Directory Service on page 48.
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6 Installing and Deploying Interstage BPM Server and
Console

When you deploy Interstage BPM Server and Console, Interstage BPM Tenant Management
Console is also automatically deployed.

Note:

Interstage BPM comes with an installation program and a Deployment Tool. The installation program
installs the product documentation, the Deployment Tool and all files required for subsequent
deployment of the Interstage BPM Server and Console to an application server of your choice. The
Deployment Tool walks you through the required configuration steps and performs the actual
deployment to an application server.
This chapter explains how to perform server and console installation using the installation program
and the Deployment Tool in graphical mode.
Installation and deployment is a short, smooth process if you know the overall procedure and all of
the values for the parameters that you need to supply. It is recommended that read the overview of
the installation and deployment procedure before starting the installation.
Refer to System Requirements for Interstage BPM Server and Console on page 15 and to the
Release Notes for details on the required components mentioned in the procedures described in
this chapter.

If you install Interstage BPM Server on a computer that is periodically disconnected from
the network, your computer’s DHCP lease may expire while you are off line. If this happens,
TCP/IP (and therefore Interstage BPM Server) will cease functioning. Therefore, you should
use a static IP address for the computer.

Note:

If you want to change the Interstage BPM configuration after deployment, you can do so by following
the instructions in the Interstage BPM Server Administration Guide.

6.1 Permissions Required for Installation and Deployment

Permissions Required for Installation
You must have read, write and execute permissions on the installation directory of the Interstage
BPM Server and Console.

On Solaris, if you are installing as a non-root user, Interstage BPM Server will not be installed
as a package.

Note:

6.2 Overview of the Installation and Deployment Procedure
This section summarizes the steps required to install and deploy the Interstage BPM Server and
Console. The installation and deployment procedure depends on whether the database and the
application server are installed on the same or on different computers.
To connect to a Directory Service and log into Interstage BPM (except for the default Interstage BPM
user created during deployment), you must configure and start the Directory Service before starting
the Interstage BPM Server.

If you are upgrading from a previous version of Interstage BPM, refer Upgrading Interstage
BPM from Previous Versions on page 71.

Note:
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Running the Database and Interstage BPM Server on the Same Computer
1. Prepare the database and make sure that the database server is running.

Refer to section Database Server Preparation on page 19.

2. Prepare the application server and make sure it is running.
Refer to section Application Server Preparation on page 21.

3. Install Interstage BPM.
Refer to section Installing Interstage BPM on page 27.

4. If you want to connect to a Directory Service, you must configure it before starting the Interstage
BPM Server.
Refer to chapter Setting Up a Directory Service on page 48.

5. Configure the Interstage BPM Server and Console and deploy it to the application server.
Refer to section Deploying Server Instances with Console on page 38.

6. Switch on Java security.
Refer to section Switching on Java Security on page 42.

7. Start the Interstage BPM Server.
Refer to section Starting Interstage BPM Server on page 44.

Running the Database and Interstage BPM Server on Different Computers

Even if you intend to setup database and Application server on the same machine, you can
use the steps below in case you want to create database and deploy Interstage BPM Server
at different times on the same machine.

Note:

1. Prepare the database and make sure that the database server is running.
Refer to section Database Server Preparation on page 19.

2. Prepare the application server and make sure it is running.
Refer to section Application Server Preparation on page 21.

3. Install Interstage BPM on the application server computer.
Refer to section Installing Interstage BPM on page 27.

4. On the database server computer, execute the database creation script. To execute the database
creation script you need to copy it from Interstage BPM installed computer.
Refer to section Configuring the Remote Database on page 36.

5. If you want to connect to a Directory Service, you must configure it before starting the Interstage
BPM Server.
Refer to chapter Setting Up a Directory Service on page 48.

6. On the application server computer, run the Deployment Tool to deploy the Interstage BPM
Server and Console.
Refer to section Deploying Server Instances with Console on page 38.

7. Switch on Java security.
Refer to section Switching on Java Security on page 42.

8. Start the Interstage BPM Server.
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Refer to section Starting Interstage BPM Server on page 44.

6.3 Installing Interstage BPM
Use the instructions in this section to perform a new installation of Interstage BPM.

If you have a previous version of Interstage BPM Server on your computer, refer to chapter
Upgrading Interstage BPM from Previous Versions on page 71.

Note:

To install Interstage BPM:
1. Read the Release Notes located in the top-level directory of the CD-ROM.
2. Start the installation program located in the engine directory on the CD-ROM.

Installation ProgramOperating System

setupwin32.exeWindows

setupSolaris.binSolaris

setupLinux.binLinux

3. Read the Welcome screen and click Next.
4. On the Interstage Business Process Manager Installation Directory screen, specify an

installation directory. Accept the default or click Browse and navigate to a directory of your choice.
Default on Windows: C:\Fujitsu\InterstageBPM
Default on UNIX: /opt/FJSVibpm
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The installation directory path must not contain blanks or special characters such as ~ $
@. Do not specify an installation directory path that is longer than 255 characters.

Note:

Figure 4: Server Installation Directory (for Windows)
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Figure 5: Server Installation Directory (for UNIX)

5. Click Next.
6. On the JDK selection screen, specify the top-level directory of your J2SE Development Kit (JDK)

installation. If the default directory is not the top-level directory of your JDK installation, click
Browse and navigate to it.

JRE is not supported.Note:

The JDK you specify here is also used during deployment of Interstage BPM. A different version
of JDK is supported for each application server, as described in the Interstage BPM Server
Release Notes.
Example on Windows: D:\java\jdk1.6.0_22
Example on UNIX: /usr/jdk/jdk1.6.0_22
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The JDK installation path must not contain blanks or special characters such as ~ $ @.Note:

Figure 6: JDK Directory (for Windows)
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Figure 7: JDK Directory (for UNIX)

7. Click Next, and on the screen that appears, click Install to start the installation.
The installation program starts copying files to your computer. Once the files have been copied,
the Start Deployment Tool screen is displayed.

8. To launch the Deployment Tool, do one of the following:
• For Windows: A 64 bit-JVM-specific Deployment Tool and a 32 bit-JVM-specific Deployment

Tool are provided for Windows Server 2003 and Windows Server 2008.
1. Select the appropriate radio button to launch the 32 bit-specific or 64bit-specific Deployment

Tool.
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2. Click Next.

Figure 8: Start Deployment Tool - For Windows
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• For Solaris: On the Start Deployment Tool screen, select the Launch Deployment Tool
check box and click Next.

Figure 9: Start Deployment Tool - For Solaris

• For Linux: A 64 bit-JVM-specific Deployment Tool and a 32 bit-JVM-specific Deployment
Tool are provided for Linux.
1. Select the appropriate radio button to launch the 32 bit-specific or 64bit-specific Deployment

Tool.
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2. Click Next.

Figure 10: Start Deployment Tool - for Linux

If you want to configure and deploy Interstage BPM Server and Console at a later time, or
you want to create a silent deployment script, make sure that you do not launch the
Deployment Tool from this screen. Click Next and then Finish.
Refer Starting the Deployment Tool on page 34 for more information about launching the
Deployment Tool at a later time.
Refer Silent Mode Deployment and Undeployment on page 91 for more information about
creating a silent deployment script.

Note:

The installation program exits. If you selected to launch the Deployment Tool, the Deployment
Tool is started.

6.4 Starting the Deployment Tool

6.4.1 Using the Deployment Tool Start-up Script
Prerequisites:
• You have prepared the database server and the application server as explained in chapter

Preparing for Installation and Deployment of Interstage BPM Server and Console on page 19.
• You have installed Interstage BPM.
• You have set the resolution of your screen and the font size as follows:

On UNIX: 1024x768, Sans 9 pt font or 1280x1024, Sans 10 pt font
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On Windows: 1024x768, system default font

• You have the required permissions for deployment. For details, refer to section Permissions
Required for Installation and Deployment on page 25.

If you chose not to launch the Deployment Tool at the end of the installation process as described
at the end of the previous section, you can start the Deployment Tool manually.
To start the Deployment Tool:
• Run the startup script located in <Interstage BPM Installation

Directory>/server/deployment/tool:

Startup ScriptOperating System

run_windows.bat (for 32bit Java VM)
run_windows_x64.bat (for 64bit Java VM)

Windows

run_solaris.shSolaris

run_linux.sh (for 32bit Java VM)
run_linux_x64.sh (for 64bit Java VM)

Linux

On Windows (32 bit), you can also start the Deployment Tool using Start > Programs > Interstage
Business Process Manager > Launch Deployment Tool.
On Windows (64 bit), you can also start the Deployment Tool using Start > Programs > Interstage
Business Process Manager > Launch Deployment Tool (64-Bit).

run_windows_x64.bat

This is a 64bit-JVM-specific Deployment Tool provided for Windows Server 2003, Windows Server
2008.
• Use the 64bit Deployment Tool only if both your Operating System as well as Java Environment

(JVM) is 64bit. If used otherwise, the Deployment Tool will fail to start.
• Irrespective of your Operating System, if your JVM is 32bit, use the 32bit Deployment Tool.

32bit Operating Systems and 64bit JVM are incompatible and using this combination will
cause launch of Deployment Tool to fail irrespective of the version of Deployment Tool.

Note:

run_linux_x64.sh

This is a 64bit-JVM-specific Deployment Tool provided for Linux.
• Use the 64bit Deployment Tool only if both your Operating System as well as Java Environment

(JVM) is 64bit. If used otherwise, the Deployment Tool will fail to start.
• Irrespective of your Operating System, if your JVM is 32bit, use the 32bit Deployment Tool.

32bit Operating Systems and 64bit JVM are incompatible and using this combination will
cause launch of Deployment Tool to fail irrespective of the version of Deployment Tool.

Note:

6.4.2 Configuring the Deployment Tool Startup JVM
If you want to change the Deployment Tool startup Java VM, it is necessary to modify the startup
script explained in the previous section.
For example, open the script file in a text editor and correct JAVA_HOME
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Edit run_windows.bat, run_windows_x64.bat as follows:

SET JAVA_HOME=C:\Oracle\Middleware\jdk160_14_R27.6.5-32\bin\java

Edit the following files as follows:
• run_linux.sh
• run_linux_x64.sh
• run_solaris.sh

SET JAVA_HOME=/root/Oracle/Middleware/jdk160_14_R27.6.5-32/bin/java

6.5 Configuring the Remote Database
Prerequisite: You have prepared the database server as instructed in section Database Server
Preparation on page 19.

This section describes how to execute the database creation script and how to run the Deployment
Tool on the database server computer to configure the database. If you are using a local database,
you do not need to perform the instructions in this section. You will typically perform the
instructions in this section only if your database is installed on a remote computer.
How to use the database creation script:
1. From following directory on the Interstage BPM installed-machine, copy the database-related

scripts to the database machine:
Windows:
• Oracle: <install_directory>\server\deployment\dbsetup\oracle
• Microsoft SQL Server: <install_directory>\server\deployment\dbsetup\sqlserver
UNIX:
• Oracle: <install_directory>/server/deployment/dbsetup/oracle
• Microsoft SQL Server: <install_directory>/server/deployment/dbsetup/sqlserver

Database creation script for Microsoft SQL Server is provided only for Windows. This is
because Microsoft SQL Server cannot be installed on UNIX environments.

Note:

Script files to be copied (into a common directory on database machine):
• dbsetup.bat (Setup script for Windows)
• dbsetup.sh (Setup script for UNIX)
• config.bat (Configuration file for Windows)
• config.sh (Configuration file for UNIX)
• SQL script files for Oracle:

• OracleDbCreate.sql

• OracleTableCreate.sql

• SQL script files for Microsoft SQL Server:
• mssqlDbCreate.sql

• mssqlUserCreate.sql

• mssqlTableCreate.sql

• mssqlGrantPermissions.sql
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• mssqlModifyIsolationLevel.sql

2. Login to the machine where the database is installed.
3. On the database machine, navigate to the directory where you copied the script files, and edit

the following parameters in the config.bat / config.sh file:

When editing parameters, do not include values in double-quotes. An example of the correct
way to specify a value:

DATAFILE_PATH=C:\Program Files\Microsoft SQL
Server\MSSQL.1\MSSQL\Data.

Note:

Common to all databases:

DescriptionSample ValueParameter

Database User NameibpmuserUSER

Database User PasswordibpmuserpasswordPASSWORD

For Oracle:

DescriptionSample ValueParameter

Oracle System IDorclSID

System User PasswordsystempasswordSYSTEM_PASSWORD

ORACLE home directoryOn Windows:
C:\app\oracle\product\11.2.0\dbhome_1

On UNIX:
/opt/app/oracle/product/11.2.0/dbhome_1

ORACLE_HOME

Path to store data filesOn Windows:
C:\app\oracle\oradata\orc

On UNIX:
/opt/app/oracle/oradata/orcl

DATAFILE_PATH

For SQL Server:

DescriptionSample ValueParameter

Database Administrator UsersaADMIN_USER

Database Administrator
Password

adminpasswordADMIN_PASSWORD

Database Port Number1433PORT

SQLSERVER home directoryExample (On Windows):
C:\Program Files\Microsoft
SQL Server

SQLSERVER_HOME
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DescriptionSample ValueParameter

Path to store data filesOn SQL Server 2005:
C:\Program Files\Microsoft
SQL
Server\MSSQL.1\MSSQL\Data.

On SQL Server 2008:
C:\Program Files\Microsoft
SQL
Server\MSSQL10.MSSQLSERVER\MSSQL\DATA.

DATAFILE_PATH

4. Run the setup script:
• dbsetup.bat (for Windows)
• dbsetup.sh (for UNIX)

Running these scripts causes the older database to be deleted. So, when you run these
scripts for the first time, you will receive an error message saying database deletion failed.
This is correct behavior.

Note:

To configure the database:
1. On the machine where Interstage BPM is installed, if the Deployment Tool is not running, start

it.
For details, refer to section Starting the Deployment Tool on page 34.

2. On the Welcome screen of the Deployment Tool, select Server instance setup, and click Next.
For details about using the Deployment Tool, refer How to use Deployment Tool on page 39.

3. Proceed through the Deployment Tool using the Description messages on each screen, till you
reach the Database Selection screen.

4. On the Database Selection screen, select Use existing database. Complete other details
required for your database as instructed on the screen.

5. Proceed through the rest of Deployment Tool and complete deployment.

If you create the database using database creation script, validation is not executed by the
Deployment Tool. Therefore you need to confirm all of the preparation requirements described
in section Database Server Preparation on page 19 are met.

Note:

6.6 Deploying Server Instances with Console
There are two methods to deploy Server instance with Console. One is by using the Deployment
Tool and the other is by using silent deployment. This section provides information about using the
Deployment Tool.
To start the Deployment Tool, execute the appropriate startup script as described in Using the
Deployment Tool Start-up Script on page 34.

6.6.1 How to Deploy Interstage BPM Server Instance with Console
Prerequisites: You have already started the Deployment Tool
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To deploy Server Instances with Console, in the Welcome screen of the Deployment Tool, select
the Server instance setup option. After selecting this, click Next and start the Deployment wizard.
How to use Deployment Tool is described in the next section.

6.6.2 How to use Deployment Tool
The following figure shows the generic layout of the Deployment Tool.

Figure 11: Deployment Tool - General Layout

Note the following:
• You can progress through this wizard by following the displayed messages.
• To move forward in the wizard, click the Next button.
• At the setup confirmation screen, clicking Next starts deployment.
Legend:
• [A]: The title of the screen and a brief summary of the screen's contents are displayed here. In

case any of your inputs generate validation errors, these errors are also displayed here. You need
to solve these errors to be able to proceed to the next screen. Help to solve errors is displayed
in the area [B], described below.

• [B]: This area displays the description of the currently selected option or input-field in the screen.
In any screen, if on clicking Next any errors occur, these are displayed in a pop-up message window.
To move to the next screen you need to solve the detected issue. Sometimes the messages are
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shown as warning message, at which time you are allowed to progress to the next screen without
solving the issue.
To find more details about any errors that occur during deployment, you can view the deployment.log
file, available at the following location:
• On Windows: <Interstage BPM Installation directory>\server\deployment\logs

• On UNIX: <Interstage BPM Installation directory>/server/deployment/logs

Contents of deployment.log are overwritten each time the Deployment Tool is executed.Note:

6.6.3 How to Confirm Successful Deployment
If deployment was completed successfully, you will view the following screen.

Figure 12: Deployment Succeeded

If you receive the Success! pop-up message, deployment was completed successfully and you can
now proceed to the next step.
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However, if you receive the Failed! pop-up message as shown below, it means deployment failed
due to some reason.

Figure 13: Deployment Failed

To find the cause of failure, check the deployment.log, displayed at the bottom of View Log area.
Often, the cause of failure is mis-configuration of database, application server or operating system.
Based on the detected error, confirm if the database, application server or operating system was
configured correctly by referring to that element's 'Preparation' section in this guide.

6.7 User Accounts and Groups
Every user that is to work with Interstage BPM needs a user account and must be assigned to one
or more groups.
A group is a collection of users who share a function within an organization. For example, a Manager
group might contain the first-line managers in an organization. Any Interstage BPM user may be
made a member of any group.
In Interstage BPM, groups are used to determine who is responsible for carrying out a task in a
process. Activities in process definitions are assigned to so-called Roles, which are equivalent to
groups. The advantage of assigning activities to Roles (rather than individuals) is that if personnel
changes occur, only the Role definition needs to be updated, and not all the processes that use the
Role.
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To set up an Interstage BPM user account, you create an account with appropriate user rights. You
must make sure that the user names for the Interstage BPM users and the group members are
identical.

To create user accounts and groups that are valid for Interstage BPM, use only alphanumeric
characters, hyphens, and underscore characters ("_"). User names and group names must
not begin with an at character ("@") as this is used to identify Agents in Interstage BPM.

Note:

The default group used by Interstage BPM is Role. Interstage BPM administrator accounts must be
members of a special group named by default AdminRole.
If you have configured the Interstage BPM Server to use a Directory Service, you need to configure
the Directory Service before starting the Interstage BPM Server. For details, refer to chapter Setting
Up a Directory Service on page 48.
If you have configured the Interstage BPM Server to use its local user store, the Interstage BPM
Super User account has already been created in the user store. There is no need to perform further
configuration steps before starting the Interstage BPM Server. For details on creating additional user
accounts and groups, refer to the Interstage Business Process Manager User's Guide.

6.8 Switching on Java Security
Deployment Tool deploys Interstage BPM in SaaS mode. In SaaS mode, it is critical to ensure that
each tenant has access to only their own resources, and no other tenant's resources. To achieve
this security, you need to manually switch on Java security as follows:

For WebLogic:
1. When you deploy Interstage BPM, a policy.txt file is created at <Interstage BPM

Installation Directory>/server/instance/default/resources. Confirm that the content
of this policy.txt file is as given below:

grant {
permission java.security.AllPermission;

};

2. To the startWebLogic.cmd / startWebLogic.sh file located in <BEA
Home>/user_projects/domains/<Domain Name>/bin/, for the JAVA_OPTIONS variable, add the
following command level arguments:

-Djava.security.manager -Djava.security.policy=<Location of policy.txt>

For example:

...
%JAVA_HOME%\bin\java %JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS%
-Dweblogic.Name=%SERVER_NAME%
-Djava.security.manager -Djava.security.policy=C:\policy.txt
%PROXY_SETTINGS% %SERVER_CLASS%
...
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3. If you intend to invoke any custom JavaActions, JavaScripts, or Agents, the following permission
needs to be added to the policy.xml file. Refer the Interstage BPM Administration Guide for
details about its location and how to edit this file.

...
<permission
className="java.io.FilePermission"
target="<WebLogic Domain

dir>\\<server>\\<ServerName>\\cache\\EJBCompilerCache\\-"
action="read,write,execute,delete"/>
<permission
className="java.io.FilePermission"
target="<WebLogic Domain dir>\\<server>\\<ServerName>\\tmp\\-"
action="read,write,execute,delete"/>
<permission
className="java.io.FilePermission"
target="<WebLogic Domain dir>\\<server>\\<ServerName>\\-"
action="read,write,execute,delete"/>

...

For example:

...
<permission
className="java.io.FilePermission"

target="D:\\bea\\user_projects\\domains\\base_domain\\servers\\AdminServer\\cache\\EJBCompilerCache\\-"

action="read,write,execute,delete"/>
<permission
className="java.io.FilePermission"

target="D:\\bea\\user_projects\\domains\\base_domain\\servers\\AdminServer\\tmp\\-"

action="read,write,execute,delete"/>
<permission
className="java.io.FilePermission"

target="D:\\bea\\user_projects\\domains\\base_domain\\servers\\AdminServer\\-"

action="read,write,execute,delete"/>
...

4. Re-start Interstage BPM Server. For details, refer Starting Interstage BPM Server on page 44.

Additional Settings for Custom Adaptors
In case you intend to use Custom Directory Adapters to connect to remote server, you need to add
the following permission in the policy.xml file. Refer the Interstage BPM Administration Guide for
details about its location and how to edit this file.

...
<permission
className="java.net.SocketPermission"
target="*"
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action="connect,resolve"/>
...

To reflect these changes, restart the Interstage BPM Server and Console application working on the
WebLogic server. For details, refer Starting Interstage BPM Server on page 44.

6.9 Starting Interstage BPM Server
Prerequisites:
• If you are using a Directory Service, you must have configured that Directory Service for Interstage

BPM. For details, refer to chapter Setting Up a Directory Service on page 48.
• The WebLogic Administration Server is running.
• You have switched on Java security. For details, refer Switching on Java Security on page 42.

Stop and re-start Interstage BPM Server:
1. Stop the Interstage BPM Server by running the shutdown script located in

<MW_Home>/user_projects/domains/<Domain Name>/bin:

ScriptOperating System

stopManagedWebLogic.cmd <Server Name>

Example:
stopManagedWebLogic.cmd IBPMServer

Windows

stopManagedWebLogic.sh <Server Name>

Example:
stopManagedWebLogic.sh IBPMServer

UNIX

For <Server Name>, specify the name that you defined when deploying the Interstage BPM
Server.

2. Run the startup script located in <MW_HOME>/user_projects/domains/<Domain Name>/bin

ScriptOperating System

startManagedWebLogic.cmd <Server Name>

Example:
startManagedWebLogic.cmd IBPMServer

Windows

startManagedWebLogic.sh <Server Name>

Example:
startManagedWebLogic.sh IBPMServer

UNIX

For <Server Name>, specify the name that you defined when deploying the Interstage BPM
Server.

3. When asked by the startup script, enter the name and password of the administrator for the
WebLogic Administration Server.
Upon successful initialization of the Interstage BPM Server, the following message appears near
the end of the Console Window:
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<Server started in RUNNING mode>

Interstage BPM Server for WebLogic is now ready to use.

6.10 Starting Interstage BPM Console and Tenant Management
Console
Prerequisites:
The WebLogic Administration Server where you have deployed Console is running.

When Interstage BPM Console is deployed on WebLogic, starting the Interstage BPM Server also
starts Interstage BPM Console and Tenant Management Console. For details of starting Interstage
BPM Server, refer section Starting Interstage BPM Server on page 44
When Interstage BPM Console is deployed on a different WebLogic domain than the Interstage BPM
Server, starting the WebLogic managed server on which Console is deployed starts Interstage BPM
Console. For details, refer Interstage BPM Server Release Notes.
To access Interstage BPM Console or Tenant Management Console:
1. In a Web browser

• To access the Interstage BPM Tenant Management Console, enter the URL
http://<hostname>:<port>/console/TenantManager.page

• To access the Interstage BPM Console, enter the URL
http://<hostname>:<port>/console/<TenantName>/

Here:
• <hostname> is the machine name of the computer upon which you have deployed the Interstage

BPM Console.
• The default port is 49950.
• <TenantName> is the name of the tenant; if you configure non-SaaS mode, this is default.
• It is recommended to use the tenant name in the URL with the same case as it has been

created with during deployment. However, tenant name in the URL is not case sensitive.
The Login page appears.

2. Log on to Interstage BPM Console or Tenant Management Console.

You can now begin using Interstage BPM Console and Tenant Management Console. Refer the
Interstage BPMConsole Online Help and Interstage BPM Tenant Management Console Online Help
for details.
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7 Configuring Interstage BPM Console to work with
Interstage Analytics
The following section provides information about configuring Interstage BPM Console to work with
Interstage Analytics v12.0 and v11.1.
To set up Interstage BPM for Interstage Analytics, use the Analytics Setup Wizard provided by the
Deployment Tool.

Using the Analytics Setup Wizard
Prerequisites:
• Complete the deployment of Interstage BPM Server and Console.
• If using Interstage Analytics v11.1, ensure you have installed Interstage Analytics and Interstage

BPM (Server and Console) on the same machine.
• Prepare JAR files of Interstage Analytics.

If you install and deploy Interstage Analytics on the same machine with Interstage BPM, Interstage
Analytics files are stored in the Interstage Analytics deployment directory. The following are
examples of Interstage Analytics JARS directories. If you install and deploy Interstage Analytics
on a different machine than Interstage BPM, then copy the following directories to the local
machine.
• On WebLogic

Windows: <Interstage Analytics Installation directory>\bpmm\ibpmm\WEB-INF\lib
(This is the default deployment directory written in the Interstage Analytics Installation Guide.)
On UNIX: /var/opt/FJSVibpma/ibpmm/WEB-INF/lib (This is the default deployment directory
written in the Interstage Analytics Installation Guide.)

To run the Interstage Analytics Setup Wizard:
1. Start the Deployment Tool. For details, refer Starting the Deployment Tool on page 34.
2. On the Welcome screen, select External setup, and click Next.
3. Confirm that Interstage Analytics feature is selected on the Feature Selection screen, and

click Next.
4. On the Analytics Setup screen, input values for all fields. For description of each field, view the

Description area at the bottom of the Deployment Tool screen.
5. Progress through, and complete the Analytics Setup wizard.
Execute the remaining steps as described in the Interstage Analytics Installation Guide.
Notes for Interstage Analytics in secure mode:
• If you have implemented SSL for Interstage BPM Console, set the InterstageAnalyticsProtocol

Console configuration parameter (in the console.conf file) to https.
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If both Interstage BPM Console and Interstage BPM Analytics are using different domains
(for example, Interstage BPM Console using local domain and Interstage BPM Analytics
using a remote domain), then Interstage BPM Console does not operate properly. To avoid
this either of the following settings is required for Internet Explorer:

Note:

• Add Interstage BPM Console and Interstage BPM Analytics address to local Intranet or
to Trusted sites in Tools >Internet Options > Security.

• Add Interstage BPM Console and Interstage BPM Analytics domain to Per Site Privacy
Actions as Allow in Tools >Internet Options > Privacy > Sites.
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8 Setting Up a Directory Service
This chapter provides instructions for setting up your Directory Service.

8.1 Setting Up Microsoft® Active Directory
This section provides instructions for setting up Microsoft® Active Directory. Active Directory uses a
form of the Lightweight Directory Access Protocol (LDAP). Like all LDAP-type Directory Services,
Active Directory organizes people into Groups, and maintains a user profile with the appropriate
permissions for each user.
The Active Directory setup procedure must be performed on the domain controller for your network
by an Administrator.

8.1.1 Configuring Users and Groups for Interstage BPM with GUI of
Microsoft® Active Directory
This section explains how to configure users and groups for Interstage BPM with the GUI of Microsoft
Active Directory.
1. Create an Organizational Unit (ou) named as Groups.

This ou should also be specified on the LDAP Configuration for Default Tenant screen during
Interstage BPM deployment. (You can change this value to another value.)
a) Open the Active Directory Management Console (Active Directory Users and Computers).
b) In the Console tree, right-click the required domain, select New, and click Organizational

Unit.
c) Type the name of the organizational unit (Groups).
The following are common rules for configuring users and groups for Interstage BPM:
• To create Groups that are valid for Interstage BPM, use only alphanumeric characters, hyphens,

and underscore characters ("_"). Group names must not begin with an 'at' character ("@") as
this is used to identify Agents in Interstage BPM.

2. Create an Organizational Unit (ou) named as People.
(You cannot change this value to another value.)
a) Open the Active Directory Management Console (Active Directory Users and Computers).
b) In the Console tree, right-click the required domain, select New, and click Organizational

Unit.
c) Type the name of the organizational unit (People).
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At this point, the directory tree of LDAP root looks as follows:

Figure 14: Creating Groups and People

3. Create LDAP-access user.
This user is specified as SuperUser during the deployment of Interstage BPM. For example, here
we use ibpm_server1 as LDAP-access user.
a) Open the Active Directory Management Console (Active Directory Users and Computers).
b) Right-click the People object, click New, and select User.
c) Enter the new user's information for ibpm_server1 and click Next.

For the user, Active Directory requires you to provide a First name, Last name, Full name,
and User logon name. Interstage BPM requires both a user login name and password to log
in.

d) Enter the user's password, and click Next.
e) Confirm the adding of the new user by clicking Finish in the confirmation dialog box.

Although entering a password and confirming it are optional for Active Directory, Interstage
BPM requires a password to log in. The other fields such as E-Mail, Phone, and Fax are
not used by Interstage BPM.

Note:
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At this point, the directory tree of People looks like the following:

Figure 15: Directory Tree of People

4. Create the default Interstage BPM roles Role and AdminRole belonging to the Organizational
Unit Groups.
a) Open the Active Directory Management Console (Active Directory Users and Computers).
b) Right-click the Groups object, click New and then select Groups.
c) Create the group's information for AdminRole.
d) Double-click the AdminRole object, and navigate to the Member tab.
e) Click Add, and enter ibpm_server1. Now ibpm_server1 is linked to AdminRole group.
f) Repeat these steps to create the Role group, and add ibpm_server1 to the Role group.

5. Create the IflowUsers group belonging to the Organizational Unit Groups.
a) Open the Active Directory Management Console (Active Directory Users and Computers).
b) Right-click the Groups object, click New and then select Groups.
c) Create the group's information for IflowUsers. Also, create this object as Distribute.
d) Double-click the IflowUsers object, and navigate to the Member tab.
e) Click Add, and enter ibpm_server1.

6. Create the IflowGroups group belonging to the Organizational Unit Groups.
a) Open the Active Directory Management Console (Active Directory Users and Computers).
b) Right-click the Groups object, click New and then select Groups.
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c) Create the group's information for IflowGroups. Also, create this object as Distribute.
d) Double-click the IflowGroups object, and navigate to the Member tab.
e) Click Add, and enter AdminRole.
f) Similarly, add Role to IflowGroups.
At this point, the directory tree of Groups looks like the following:

Figure 16: Directory Tree of Groups

You have now completed the configuration for Active Directory. You can now deploy Interstage BPM
with Microsoft Active Directory.

8.1.2 Using Existing Active Directory Users and Groups
If you are new to Interstage BPM and are already using Active Directory as the Directory Service to
maintain your organization's Users and Groups, you can use your existing directory structure with
Interstage BPM. You can do this by designating your LDAP Users as Interstage BPM users and your
LDAP Groups as Interstage BPM Roles. This involves the modification of two special LDAP Groups,
IflowUsers and IflowGroups.
To give your LDAP Users access to Interstage BPM as Interstage BPM users, add them as members
of the IflowUsers group. You can add each user individually or add a group that contains the users.
Users in the group sub-levels are also given access. To give your LDAP Groups access to Interstage
BPM as Interstage BPM Roles, add them as members of the IflowGroups group.
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8.1.3 Adding New Users Using the GUI
To create users that are valid for Interstage BPM, use only alphanumeric characters,
hyphens, and underscore characters ("_"). User names must not begin with an at character
("@") as this is used to identify Agents in Interstage BPM.

Note:

To add new users using the ActiveDirectory GUI:
1. Launch the Active Directory Console if you haven't already done so by selecting Start > Settings

> Control Panel > Administrative Tools > Active Directory Users and Computers. Expand
the host name and the domain name to find the people Organizational Unit.

2. Right click people.
3. From the popup menu, select New, and then select User to open the New Object - User dialog.

Figure 17: Adding a New User

4. Enter the new user's information and click Next.
For each user, Active Directory requires you to provide a first name, last name, full name, and
user login name.
Interstage BPM requires both a user login name and password to log in.
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5. Enter the user's password, and then click Next.

Figure 18: Adding a New User
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6. Confirm the adding of the new user by clicking Finish in the confirmation dialog.

Figure 19: Adding a New User

Use the New Object - User dialog to create as many new user profiles as you want.

7. Add the new user to IflowUsers so that the new user is recognized by Interstage BPM. To do
so:
a) In theActive Directory Users and Computerswindow, expand the host name and the domain

name to find the main Organizational Unit that you specified during Interstage BPM installation.
b) Right click the IflowUsers Group and select Properties from the popup menu.
c) Select the Members tab and click Add.

The Select Users, Contacts, Computers, or Groups dialog appears.

d) Enter the name of the new user that is to be added to IflowUsers. Click Check Names to
verify the user name.

e) Click OK.

8.1.4 Adding New Groups Using the GUI
To create Groups that are valid for Interstage BPM, use only alphanumeric characters,
hyphens, and underscore characters ("_"). Group names must not begin with an at character
("@") as this is used to identify Agents in Interstage BPM.

Note:
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To add a new Group using the GUI:
1. Launch the Active Directory Console if you haven't already done so by selecting Start > Settings

> Control Panel > Administrative Tools > Active Directory Users and Computers. Expand
the host name and the domain name to find the groups Organizational Unit.

2. Right click groups.
3. From the popup menu, select New, and then select Groups to open the New Object - Groups

dialog.
4. Add the new Group's information, and then click OK to add your new Group.

In the example below, the Group Role is added.

Figure 20: Adding New Groups

5. Confirm the adding of the new Group by clicking Finish in the confirmation dialog box.
Use the New Object - Groups dialog to create as many new user profiles as you want.
For each Group, Active Directory requires you to provide a unique name for your Group.

6. Add the new Group to IflowGroups so that the new Group is recognized by Interstage BPM. To
do so:
a) In theActive Directory Users and Computerswindow, expand the host name and the domain

name to find the main Organizational Unit that you specified during Interstage BPM installation.
b) Right click the IflowGroups Group and select Properties from the popup menu.
c) Select the Members tab and click Add.

The Select Users, Contacts, Computers, or Groups dialog appears.
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d) Enter the name of the new Group that is to be added to IflowGroups. Click Check Names
to verify the Group name.

e) Click OK.

8.1.5 Adding Members to a Group Using the GUI
After normal installation using Active Directory, the default Administrator Role is a Group
called AdminRole. You can change this default name by modifying the AdminRole parameter
of the Interstage BPM Server.

Note:

To add members to a Group using the GUI:
1. Launch the Active Directory Console if you haven't already done so by selecting Start > Settings

> Control Panel > Administrative Tools > Active Directory Users and Computers. Expand
the hostname and the domain name to find the groups Organizational Unit.

2. Right click the group to which you want to add members.
3. From the popup menu that appears select Properties, and then select theMembers tab to display

the Group's properties dialog.
The Properties dialog for the Role Group is used in the following example. ibpm_example is
already a member of the Role Group.

Figure 21: Adding Members
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4. In the Role Properties dialog, click Add.
The Select Users, Contacts, Computers, or Groups dialog appears.

5. In Windows® 2003 Server, search a user or Group that you want to add as a member of the
Group.
The user or Group appears in the bottom text area of the dialog.

Figure 22: Selecting a User

6. Click OK.
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The user appears with the existing users in the Properties dialog.

Figure 23: New Member Added

7. To theAdminRoleGroup, add the IDs of all Interstage BPM users who will create WFAdminSession
objects through Java. This Group should at least include the Interstage BPM Administrator account
that you defined during deployment.

8.2 Setting Up Oracle Directory Server Enterprise Edition
Oracle Directory Server Enterprise Edition uses a form of the Lightweight Directory Access Protocol
(LDAP). Like all LDAP-type Directory Services, it organizes people into Groups, and maintains a
user profile with the appropriate permissions for each user.
To use Interstage BPM with Oracle Directory Server Enterprise Edition, you must customize your
Oracle Directory Server Enterprise Edition installation as follows:
• Start the Oracle Directory Server Enterprise Edition.
• Create suffixes on Oracle Directory Server Enterprise Edition for Interstage BPM.
• Configure users and Groups to use Interstage BPM.
• Add general users and general Groups to the Directory Service.
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8.2.1 Starting the Oracle Directory Server Enterprise Edition
Prerequisite:
• Install the Oracle Directory Server Enterprise Edition.
• Create a Directory Server Instance.

You can start the Directory Server using the dsadm command or Directory Service Control Center.
For details, refer Oracle Directory Server Enterprise Edition Installation Guide 11g Release 1 .

8.2.2 Create suffixes on Oracle Directory Server Enterprise Edition for
Interstage BPM
Do the following:
1. In Oracle Directory Service Control Center, navigate to the Suffixes tab.
2. Click New Suffix and configure the suffix using the wizard. Ensure the following:

a) In the Choose Replication Option screen, select Do Not Replicate Suffix.
b) In the Choose Server(s) screen, select Choose by Server.
c) In the Choose Settings screen, select Use Default Settings.
d) Check the Use Default Database Location and Leave Suffix not Initialized options.

8.2.3 Configuring Users and Groups for Interstage BPM with GUI of
Oracle Directory Server Enterprise Edition
This section explains how to configure users and groups for Interstage BPM with the GUI of Oracle
Directory Server Enterprise Edition.
1. Create an Organizational Unit (ou) named as Groups.

This ou should also be specified on the LDAP Configuration for Default Tenant screen during
Interstage BPM deployment. (You can change this value to another value.)
a) Open the Oracle Directory Service Control Center, and select the Browse tab of Entry

Management.
b) Specify the DN that you want to use in the View DN drop-down list.
c) Click New Entry to start the New Entry wizard.
d) In the Choose Object Class screen, for Entry Type, select Organizational Unit-

(organizationalUnit).
e) In the Configure Attribute screen, enter Groups for the Organization Unit (ou).
The following are common rules for configuring users and groups for Interstage BPM:
• To create users that are valid for Interstage BPM, use only alphanumeric characters, hyphens,

and underscore characters ("_"). User IDs must not begin with an 'at' character ("@") as this
is used to identify Agents in Interstage BPM.

2. Create an Organizational Unit (ou) named as People.
(You cannot change this value to another value.)
a) In the Oracle Directory Service Control Center, select the Browse tab of Entry Management.
b) Specify the DN that you want to use in the View DN drop-down list.
c) Click New Entry to start the New Entry wizard.
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d) In the Choose Object Class screen, for Entry Type, select Organizational Unit-
(organizationalUnit).

e) In the Configure Attribute screen, enter People for the Organization Unit (ou).

Although entering a password and confirming it are optional for Oracle Directory Server
Enterprise Edition, Interstage BPM requires a password to log in. The other fields such as
E-Mail, Phone, and Fax are not used by Interstage BPM.

Note:

At this point, the directory tree of LDAP root looks as follows:

Figure 24: Creating Groups and People

3. Create LDAP-access user.
This user is specified as SuperUser during the deployment of Interstage BPM. For example, here
we use ibpm_server1 as LDAP-access user.
a) In the Oracle Directory Service Control Center, select the Browse tab of Entry Management.
b) Under the People group you created earlier, click New Entry and start the New Entry wizard.
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c) In the Choose Object Class screen, for Entry Type, select User - (inetOrgPerson).
d) In the Configure Attribute screen, enter ibpm_server1 for cn and sn fields of Required

Attributes.
e) In the Configure Attribute screen, enter ibpm_server1 for User ID(uid) field of Allowed

Attributes. Also enter information for Password and Confirm Password fields.
At this point, the directory tree of People looks like the following:

Figure 25: Directory Tree of People

4. Create the default Interstage BPM roles Role and AdminRole belonging to the Organizational
Unit Groups.
a) In the Oracle Directory Service Control Center, select the Browse tab of Entry Management.
b) Under the Groups group you created earlier, click New Entry and start the New Entry wizard.
c) In the Choose Object Class screen, for Entry Type, select Static Group -

(groupOfUniqueNames).
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d) In the Configure Attribute screen, enter AdminRole for Full Name (cn) field of Required
Attributes.

e) In the Configure Attribute screen, in Allowed Attributes, for both Groups select the default
user you created in the previous step.

f) Similar to the steps just performed for AdminRole, repeat these steps for Role.

5. Create the IflowUsers group belonging to the Organizational Unit Groups.
a) In the Oracle Directory Service Control Center, select the Browse tab of Entry Management.
b) Under the Groups group you created earlier, click New Entry and start the New Entry wizard.
c) In the Choose Object Class screen, for Entry Type, select 'Static Group -

(groupOfUniqueNames).
d) In the Configure Attribute screen, enter IflowUsers for Full Name (cn) field of Required

Attributes.
e) In the Configure Attribute screen, in Allowed Attributes, add ibpm_server1 for Group

Member (uniqueMember) field. By using the Add button, for both Groups select the default
user you created in step 3.

6. Create the IflowGroups group belonging to the Organizational Unit Groups.
a) In the Oracle Directory Service Control Center, select the Browse tab of Entry Management.
b) Under the Groups group you created earlier, click New Entry and start the New Entry wizard.
c) In the Choose Object Class screen, for Entry Type, select 'Static Group -

(groupOfUniqueNames).
d) In the Configure Attribute screen, enter IflowGroups for Full Name (cn) field of Required

Attributes.
e) In theConfigure Attribute screen, inAllowed Attributes, add AdminRole and Role forGroup

Member (uniqueMember) field. By using the Add button, you can select AdminRole and
Role you created in step 4.
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At this point, the directory tree of Groups looks like the following:

Figure 26: Directory Tree of Groups

7. Configure ACI.
a) In the Oracle Directory Service Control Center, select the Access Control tab of Entry

Management.
b) Click New ACI from Syntax and start the New ACI wizard.
c) Enter information for the ACI Syntax and Entry where the ACI is located.

ACI Syntax:(target = ldap:///'Suffix') (targetattr="*") (version 3.0; acl
"'ACIName'"; allow (all) (userdn = "ldap:///uid='username',ou=People,'Suffix'")
;)

Example:

(target = ldap:///dc=xxxx,dc=fujitsu,dc=com) (targetattr="*")
(version 3.0; acl "Enable Full access for IBPM admin user"; allow
(all)
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(userdn =
"ldap:///uid=ibpm_server1,ou=People,dc=xxxx,dc=fujitsu,dc=com") ;)

Entry where the ACI is located: Suffix
Example:

dc=xxxx,dc=fujitsu,dc=jp

You have now completed the configuration for Oracle Directory Server. You can now deploy Interstage
BPM with Oracle Directory Server Enterprise Edition.

8.2.4 Using Existing Oracle Directory Server Enterprise Edition Users
and Groups
If you are new to Interstage BPM and are already using Oracle Directory Server Enterprise Edition
as the Directory Service to maintain your organization's users and Groups, you can use your existing
directory structure with Interstage BPM. You can do this by designating your LDAP Users as Interstage
BPM users and your LDAP Groups as Interstage BPM Roles. This involves the modification of two
special LDAP Groups, IflowUsers and IflowGroups.
These two special LDAP Groups can be used to allow your LDAP Users and Groups access to
Interstage BPM.
To give your LDAP Users access to Interstage BPM as Interstage BPM users, add them as members
of the IflowUsers Group. You can add each user individually or add a Group that contains the users.
Users in the Group sub-levels are also given access. To give your LDAP Groups access to Interstage
BPM as Interstage BPM Roles, add them as members of the IflowGroups Group.

8.2.5 Adding New Oracle Directory Server Enterprise Edition Users
When you want to add a new user as a general Interstage BPM user, you need to create a user that
belongs to ou=People.
To add a new user:
1. Open the Oracle Directory Service Control Center, and select the Browse tab of Entry

Management.
2. Under the People group, click New Entry and start the New Entry wizard.
3. In the Choose Object Class screen, for Entry Type, select User - (inetOrgPerson).
4. In the Configure Attribute screen, enter the username of the new user in the cn and sn fields

of Required Attributes.
5. In the Configure Attribute screen, enter the LDAP User ID for User ID(uid) field of Allowed

Attributes. Also enter information for Password and Confirm Password fields.

8.2.6 Adding New Groups
After a normal installation using the Oracle Directory Server Enterprise Edition, the default
Administrator Group is called AdminRole. You can change this default name by modifying the
AdminRole parameter of the Interstage BPM Server. For the parameter description, refer the Interstage
BPM Server Administration Guide. To this Group, add the IDs of all Interstage BPM users who will
access administration functions in the Interstage BPM Console or create WFAdminSession objects
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through Java. This Group should at least include the Interstage BPM Administrator account that you
defined during deployment (typically ibpm_server1).
When you want to add new groups as general Interstage BPM group, you need to create a group
and add it to Role group.
1. Open the Oracle Directory Service Control Center, and select the Browse tab of Entry

Management.
2. Under the Groups group, click Edit Entry to start the Edit Entry wizard for the Role group.
3. In the Allowed Attributes screen, add the group you want by using the Add button.

8.3 Group Caching
When the Interstage BPM Server starts up, Interstage BPM connects to the Directory Service and
copies all of the user and Group information defined in LDAPUsersDN and LDAPGroupsDN to a cache
on the Interstage BPM Server. This increases Interstage BPM performance because user and Group
information no longer has to be retrieved from the Directory Service, which might be running on a
separate network computer. It retrieves it from the LDAP Cache that is on the local computer in
memory.
If the cache is not updated, users added since the start of the Interstage BPM Server would not be
able to login to or use Interstage BPM. To avoid this, the cache has to be updated periodically.
The LDAPGroupCacheAgeSec parameter of the Interstage BPM Server specifies how often the LDAP
Cache is updated. Groups that have been in service for longer than the period of time specified in
the LDAPGroupCacheAgeSec parameter are checked, and new user and Group information is retrieved
from the Directory Service. The default value for this parameter is 3600 seconds; that is, the LDAP
Cache will be checked every hour. If this parameter is set to -1, new user and Group information is
retrieved from the Directory Service every time it is needed. Refer to the Interstage Business Process
Manger Server Administration Guide for more information about the configuration parameters of the
Interstage BPM Server.
Each entry in the cache has a timestamp that is set to the last time that group was read from the
Directory Service. Whenever someone calls the Directory Adapter to fetch a Group, the Directory
Adapter checks if that Group is in the cache:
• If the Group requested is not in the cache, it is read in and timestamped with the current time.
• If the Group requested is already in the cache, the timestamp is checked. If the Group was

timestamped before the previous cache check (it is at a time before LDAPGroupCacheAgeSec
seconds ago), then just that Group is deleted from the LDAP Cache and read back in from the
Directory Service. All other Groups in the cache are unaffected.

8.4 User Attribute Caching
The generic structure of an Interstage BPM user's profile is stored using multiple user attributes.
These attribute values include the user's ID, email, manager or subordinate's ID, and so on. Inclusion
of manager or subordinate information in the Interstage BPM user profile allows mapping of your
company’s organization and people structure so that Interstage BPM can further use this information.
The RequiredUserAttribute property of Interstage BPM stores names of user attributes that are
necessary to be defined for a user profile.
All attributes specified for RequiredUserAttribute are not cached. Only attributes for which the
cache option is specified are cached. Storing attributes in the local database cache allows Interstage
BPM to quickly search and retrieve these attribute values for any user, from the cache. Retrieved
attribute values can further be used for different purposes (for example, directly allocating a task to
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a particular user's manager or subordinate, or viewing what tasks a user’s subordinates are allocated
to).
Interstage BPM server refreshes the user attribute values in the cache in the following scenarios:
• When you modify the value of the RequiredUserAttribute Interstage BPM property
• When you call the Model API WFAdminSession.refreshAllUserProfileCache() method

8.5 Changing Username and Password of Tenant Owner
When a tenant is created, the Tenant Owner name and password specified while creation of the
tenant are stored in Interstage BPM Server tenant properties of ServerUserName, ServerPassword
and in LDAPAccessUserID, LDAPAccessUserPassword for LDAP-related directory services.
If you change Tenant Owner name or password then please do not forget to change these Interstage
BPM Server tenant properties as well and also re-activate the tenant.
But, if you use Local User Management (LUM) as a directory service and change the Tenant Owner
password then ServerPassword will be changed automatically at the same time. In this scenario,
you need not re-activate the tenant.
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9 Undeploying andUninstalling InterstageBPMServer
and Console
This chapter explains how to undeploy Interstage BPM Server and Console from an application
server and how to uninstall Interstage BPM.

9.1 Undeploying Interstage BPM Server and Console from the
Application Server
Prerequisite: The WebLogic Administration Server is running.

You can undeploy an instance of the Interstage BPM Server and Console from the application server
using the Interstage BPM Deployment Tool.

When you remove a server or console instance, the Interstage BPM database will not be
removed.

Note:

To undeploy an Interstage BPM Server and Console instance:
1. Log out of all Interstage BPM Clients and close all Browser windows.
2. Stop the Interstage BPM Server by running the shutdown script located in

<MW_Home>/user_projects/domains/<Domain Name>/bin:

ScriptOperating System

stopManagedWebLogic.cmd <Server Name>

Example:
stopManagedWebLogic.cmd IBPMServer

Windows

stopManagedWebLogic.sh <Server Name>

Example:
stopManagedWebLogic.sh IBPMServer

UNIX

For <Server Name>, specify the name that you defined when deploying the Interstage BPM
Server.

3. Start the Interstage BPM Deployment Tool.
For details, refer to section Starting the Deployment Tool on page 34.

4. On the Welcome screen, click Server Instance Removal.
5. Progress through the wizard using the explanations provided in the Description area for each

field.

During undeployment, in the Deployment screen, almost all field values are present, and
are the same as those entered during deployment. You only need to specify the password.

Note:
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9.2 Uninstalling Interstage BPM
When you uninstall Interstage BPM using its uninstallation program, everything except the following
is removed:
• The Interstage BPM database
• Log files and configuration files located in <Interstage BPM Server Installation Directory>

or in one of the subdirectories
During uninstallation, the Deployment Tool is started so that you can remove Interstage BPM Server
from the application server if you have not done so yet.
To uninstall Interstage BPM:
1. If you have not yet removed the Interstage BPM Server/Console from the application server:

a) Log out of all Interstage BPM Clients and close all Browser windows.
b) Make sure that the WebLogic Administration Server is running.
c) Stop the Interstage BPM Server by running the shutdown script located in:

• <BEA_HOME>/user_projects/domains/<Domain Name>/bin on WebLogic Application
Server 9.2.

• <MW_HOME>/user_projects/domains/<Domain Name>/bin on WebLogic Application
Server 10.3.2

ScriptOperating System

stopManagedWebLogic.cmd <Server Name>

Example:
stopManagedWebLogic.cmd IBPMServer

Windows

stopManagedWebLogic.sh <Server Name>

Example:
stopManagedWebLogic.sh IBPMServer

UNIX

d) When asked by the script, enter the name and password of the administrator for the WebLogic
Administration Server.

2. Start the Interstage BPM uninstallation program:
• On Windows, select Start > Programs > Interstage Business ProcessManager >Uninstall.

Alternatively, you can use the Windows Control Panel (Start > Settings > Control Panel >
Add or Remove Programs > Interstage Business Process Manager)

• On UNIX, run <Interstage BPM Server Installation Directory>/_uninst/uninstall.sh.

3. On the Welcome screen, click Next.
4. Depending on your platform, do any of the following:

• On Windows: Select the appropriate radio button on the Deployment Tool Option Screen
and click Next.
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If you have already removed the Interstage BPM Server and Console from the application
server, make sure that you select the Do not launch Deployment Tool radio button.

Note:

Figure 27: Start Deployment Tool - For Windows

• On Linux: Select the appropriate radio button on the Deployment Tool Option Screen and
click Next.
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If you have already removed the Interstage BPM Server and Console from the application
server, make sure that you select the Do not launch Deployment Tool radio button.

Note:

Figure 28: Start Deployment Tool - For Linux

• On platforms other than Windows or Linux: On the Uninstaller screen, check/uncheck
the Start Deployment Tool checkbox depending on whether or not you want to undeploy
before uninstallation. Then click Next.

5. If you decided to launch the Deployment Tool, do one of the following:
• If you have already removed the Interstage BPM Server and Console from the application

server, click Cancel to exit the Deployment Tool.
• If you have not yet removed the Interstage BPM Server and Console from the application

server, click Server/Console instance removal to start the removal process.
For further instructions, refer to sectionUndeploying Interstage BPMServer and Console from
the Application Server on page 67.

In either case, after exiting the Deployment Tool, you will return to the uninstallation program.

6. On Windows, when asked if you want to completely remove the selected application and all of
its features, click Yes /Next.

7. During uninstallation, the uninstallation program may ask you to confirm the deletion of some
files. Decide whether you want to keep or remove the files.

8. When the uninstallation is complete, click Finish.
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10 Upgrading Interstage BPM from Previous Versions
10.1 Upgrading from Previous Versions of Interstage BPM

To upgrade from previous versions of Interstage BPM:
1. Before uninstalling the previous version of Interstage BPM:

• Back up the Interstage BPM database - This is the only way to ensure the retention of your
current Interstage BPM data. The upgrade process automatically migrates (and therefore
overwrites) process definitions to the current release's formats. Use the default functionalities
of your database software for backing up your database.

• Export out the Interstage BPM Server properties using the Interstage BPM export script. (For
details, refer Using the Configuration Export and Import Scripts on page 83.) This preserves
your previous server configurations. (If upgrading from Interstage BPM v7.x or v8.x, the
uninstallation program automatically saves your configuration files with the suffix previous
appended to their file names. For example, the ibpm.properties file is saved as
ibpmprevious.properties. ) After installing the new version of Interstage BPM, you can use
the saved properties file to manually configure your new server installation. For information
on how to change the server configuration, refer to the Interstage Business Process Manager
Server Administration Guide.

• Back up all files from the previous agents/ folder
• Back up all files from the previous calendar/ folder
• Back up the resources/DataSourceDefinition.xml file
• Back up the resources/fileListenerConf.xml file
• Back up the DmsCollections.xml file and the directories specified in it - these directories

contain data that users have previously uploaded.

2. Uninstall the previous version of Interstage BPM according to the instructions for that version.
3. Make sure that you have the required permissions for installation and deployment.

For details, refer to section Permissions Required for Installation and Deployment on page 25.

4. Install Interstage BPM Server according to the instructions in section Installing Interstage BPM
on page 27.

5. Upgrade your database as follows:
a) If the Deployment Tool is not running, start it using the instructions in section Starting the

Deployment Tool on page 34.
b) On the Welcome screen of the Deployment Tool, select Upgrade.
c) Click Next.
d) On the Database Selection screen, select the database system you are using.
e) Click Next.
f) On the Database Configuration screen, specify the settings for your database.

If you are migrating from an Interstage BPM Advanced Edition, select the Upgrade from
AE to EE Version check box.

If you are upgrading from an Interstage BPM Enterprise Edition, do not select the Upgrade
from AE to EE Version check box. Otherwise, your database may get incorrectly updated.

Note:

g) Click Next.
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h) Make sure that all the information displayed on the Setup Confirmation screen is correct.
i) Click Next to start upgrading the database.

At the end of the process, a message is displayed notifying you that the database has been
upgraded.

j) Click OK to exit the Deployment Tool.

6. Deploy the Interstage BPM Server and/or Console according to the instructions in sectionDeploying
Server Instances with Console on page 38.

On the <Database> Setting screen, do not select the Create New Database option.
Otherwise, the old database will be overwritten and you will lose all of the previous work
that is stored in the database.

Note:

Once upgrade is completed, the ApplicationSecurityMode server configuration parameter
is set to Secure (SaaS mode). Therefore if you want to keep using Interstage BPM with
non-SaaS mode, you should change the property value from Secure to Relax. How to
change server parameters is described in the Interstage BPM Server Administration Guide.

Note:

7. Migrate application resources as described in Migrating Application Resources from Previous
Versions to this Version of Interstage BPM on page 72.

8. Start the Interstage BPM Server and Console. Refer the following topics:
• Starting Interstage BPM Server on page 44
• Starting Interstage BPM Console and Tenant Management Console on page 45

9. If needed, migrate application owners as described inMigrating Application Owners from Previous
Versions to this Version of Interstage BPM on page 74.

10. For security reasons, delete the configuration file (of step 1) after using it.

Interstage BPM is now upgraded to the latest version.

10.2 Migrating Application Resources from Previous Versions
to this Version of Interstage BPM
Pre-requisites: You have completed the following steps as described in Upgrading from Previous
Versions of Interstage BPM on page 71:
• You have uninstalled the previous version of Interstage BPM
• You have installed the new version of Interstage BPM
• You have upgraded the database
• You have deployed an instance of Interstage BPM Server, and after deployment, you have

changed the ApplicationSecurityMode server configuration parameter to relax.

To migrate application resources from previous versions to this version of Interstage BPM:
1. Copy the DmsCollections.xml file of the previous version to the <Interstage BPM Installation

Directory>/server/instance/default/tenants/Default/resources/ folder. (Replace the
DmsCollections.xml present at this location.)
Essentially, to be able to use attachments from the previous Interstage BPM version, you need
to continue to use the same DMSRoot you used in the previous version.
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2. Copy the apps folder from <Interstage BPM Installation
Directory>/server/instance/default/tenants/Default/attachments/ to the DMSRoot
<Path> specified in DmsCollections.xml.

For UNIX environments, while specifying the DMSRoot, ensure you use the correct case
in the file path.

Note:

3. For each application, do one of the following:
a) If an application already contains the agentsConfig.xml file (located in

<DMSRoot>/apps/<application id>/), add the following code to that file:

<ActionAgent>
<Name>@FTP</Name>
<Description>FTP Agent</Description>
<RetryInterval>20</RetryInterval>
<EscalationInterval>1</EscalationInterval>

<ClassName>com.fujitsu.iflow.serveree.impl.actionagent.ServiceAgent</ClassName>

<ConfigFile>ftp.xml</ConfigFile>
</ActionAgent>
<ActionAgent>

<Name>@HTTPAgent</Name>
<Description>HTTP Agent</Description>
<RetryInterval>20</RetryInterval>
<EscalationInterval>1</EscalationInterval>

<ClassName>com.fujitsu.iflow.serveree.impl.actionagent.httpservice.HTTPServiceAgent</ClassName>

<ConfigFile>HTTPAgent.xml</ConfigFile>
</ActionAgent>

b) If an application does not contain the agentsConfig.xml file (located in
<DMSRoot>/apps/<application id>/)
• Copy the agentsConfig.xml file of the previous version to the <DMSRoot>/apps/System

folder.
• Edit the copied agentsConfig.xml to remove 'agents/' from the text within the

<ConfigFile> tag.

4. Copy the fileListenerConf.xml file of the previous version to the <DMSRoot>/apps/System
directory.

5. Copy the previous versions of each of the following to each application folder in the
<DMSRoot>/apps/<application id>/ directory.
• HTTPAgent.xml file
• ftp.xml file
• Business Calendar (.cal) files
• DataSourceDefinition.xml file

Do not migrate Decision Table Management (DTM) configuration files from previous versions
of Interstage BPM; this version of Interstage BPM does not support DTM configuration files
of pre-v11.0 versions.

Note:
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From this version of Interstage BPM:Note:
• Parent process definitions can only call sub process definitions if they exist in the same

application. To continue using parent process definition from previous versions in
Interstage BPM v11.0, ensure their sub process definitions exist in the same application
as the parent process definition.

• You cannot migrate process instances from one application to another.
• You cannot copy process definitions from one application to another.

10.3 Migrating Application Owners from Previous Versions to
this Version of Interstage BPM
When you migrate applications prior to this version to this version of Interstage BPM, the user group
having the role of AdminRole is automatically set as the owner of the application. After application
migration, if you want to assign application ownership to a group other than the AdminRole, you can
do so by using Interstage BPM Console. For information about changing application owners in
Interstage BPM Console, refer the Managing Applications section of the Interstage BPM Console
Online Help.

10.4 Migrating WebDAV Repository and UDDI Registry from
Previous Versions to this Version of Interstage BPM
If you had configured Interstage BPM of the version prior to this version to use WebDAV repository
and UDDI registry (such as Centrasite), you need to configure for WebDAV and UDDI repositories.
This configuration is possible by using Interstage BPM Tenant Management Console or the
ImportProperties command.
After this configuration is complete, you need to synchronize the Interstage BPM Server with your
WebDAV and UDDI repositories before you can use already published information or publish new
process definitions. Use the following steps to achieve this:
1. After upgrade and configuration of Interstage BPM Server and Console, start the Interstage BPM

Server and Console.
• Starting Interstage BPM Server on page 44
• Starting Interstage BPM Console and Tenant Management Console on page 45

2. Login to Interstage BPM Console as an administrator.
3. After choosing an application, in the System Administration tab, click Application Settings.
4. In the Application Settings page, click Synchronize with Repository, and then click

Synchronize in the pop-up that appears.
Once synchronization is successful, an appropriate message is displayed.

Now this version of Interstage BPM is ready to be used with WebDAV and UDDI repositories

10.5 Additional Steps for Handling Pre-11.0 Console URLs
In version 11.0 of Interstage BPM Console, the Interstage BPM Console URL has been changed,
making older versions of URLs such as those of Remote SubProcesses, Service Registry, and so
on incompatible when called from previous versions of Interstage BPM.
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To overcome this problem, deploy the Compatibility Proxy WAR provided in this release using the
steps listed in this section.

Note: 1. For a remote subprocess, perform the steps listed here only in the following cases:
• When both the Parent and child process instances are running, and you upgrade

Interstage BPM on the parent server to v11.0
• When the parent process is running but the child process instance has not yet started,

and you upgrade Interstage BPM on the child server to v11.0

2. Support for HTTPS is not available in this release.

In order to use the Compatibility Proxy for supporting pre-V11.0 URLs, the following requirements
must be met:
• You should deploy an instance of Interstage BPM Server, and after deployment, you should

change the ApplicationSecurityMode server configuration parameter to relax.
• The Compatibility Proxy should be deployed at the original pre-V11 context root, and the V11

Console should be deployed at a different context root. For example, if the pre-v11.0 Console
was deployed at the context root ibpmconsole, then you should install the compatibility proxy at
ibpmconsole and the V11 Console at any other context root, for example, console. The default
context root for V11 Console is console, which is different from the default context root for any
previous version. So if you have followed the defaults, this requirement rule will be automatically
satisfied.

• V10.x had the restriction that two applications cannot have process definitions with the same
name. This restriction has been removed in V11.0. But to use the Compatibility Proxy, the same
restriction needs to be followed, that is, two applications should not have process definitions with
the same name.

10.5.1 Steps to Overcome the URL-incompatibility Problem
Pre-requisites: You have completed the following steps as described in Upgrading from Previous
Versions of Interstage BPM on page 71:
• You have uninstalled the previous version of Interstage BPM
• You have installed the new version of Interstage BPM
• You have upgraded the database
• You have deployed an instance of Interstage BPM Server and Console, and after deployment,

you have changed the ApplicationSecurityMode server configuration parameter to relax.
• Make sure that the WebLogic Server is running.

To overcome the URL-incompatibility problem caused by pre-11.0 URLs:
1. Create a folder whose name corresponds to your pre-v11.0 context root (for example ibpmconsole)

on your machine. For example purposes, the following directory will be used:
On UNIX or Linux:
/opt/FJSVibpm/ibpmconsole

On Windows:
c:\fujitsu\InterstageBPM\ibpmconsole

2. Copy webserviceproxy.war from the console directory of your Interstage BPM Console Installation
CD or CD Image to the directory that you just created on your machine.
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3. Extract the files from webserviceproxy.war into the ibpmconsole directory. Use the following
Java command:
jar -xvf webserviceproxy.war

4. After extracting the jar, edit the proxy.conf file under <Extraction Directory>\WEB-INF\config
and update the ServerBaseURL to the V11 port number and context root.

5. Start the WebLogic Server Default Server. For details, refer Starting WebLogic Administration
Server on page 23.
The WebLogic Administration Server will start in a Console Window.

6. Start the Interstage BPM Server to which you want to connect in WebLogic. For details, refer
Starting Interstage BPM Server on page 44.

7. Open the WebLogic Admin Console by entering the following URL in your Web Browser:
http://<HOSTNAME>:7001/console

The WebLogic Administration Console will open in your Web Browser.

8. Login to the WebLogic Administration Console.
9. Deploy the webserviceproxy.war on the WebLogic Application Server. See the Deploy Web

Application topic in the WebLogic Server Administration Console Help for instructions specific to
the particular version of WebLogic that you are using.

10. Deploying the webserviceproxy using the WebLogic Administration Console:

Two different scenarios are presented in these instructions. In Case 1, the webserviceproxy
is deployed in the same WebLogic Server Domain as the Interstage BPM Server. In Case
2, the webserviceproxy is deployed in a WebLogic Server Domain other than the one used
by the Interstage BPM Server.

Note:

a) In the left pane of the Administration Console, click Lock & Edit, so you can deploy the
webserviceproxy.war. This action greys out the Lock & Edit button and makes the Release
Configuration button available. The WebLogic Administration Console is now in edit mode.
The WebLogic configuration cannot be changed unless you are in edit mode.

In WebLogic 10.3.2, this step is not required if theAutomatically acquire lock and activate
changes option is enabled in your admin console Preferences.

Note:

b) In the left pane of the Administration Console, click Deployments in the Domain Structure
list. The Summary of Deployments page appears.

c) In the right pane, click Install. The Install Application Assistant page appears.
d) Click the link for Location and navigate to the ibpmconsole (where we have extracted the

webserviceproxy.war in Step 3) directory.
e) Check the ibpmconsole checkbox. Then, click Next. The Choose Targeting Style step of the

Install Application Assistant is displayed.
f) Make sure that the Install this deployment as an application checkbox is checked. Then,

click Next.
g) For Case 1, check the InterstageBPMServer checkbox in the Servers list. For Case 2, you

only have the option of using the Admin Server, so no action is needed on this screen.
h) For Case 1, click Next. For Case 2, click Finish. In Case 1, the Optional Settings step of the

Install Application Assistant is displayed. In Case 2, you can skip the next step.
i) You do not need to make any optional settings, so click Next.
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j) Activate your deployment by clicking Activate Changes. A message appears informing you
that your changes have been activated.

In WebLogic 10.3.2, this step is not required if theAutomatically acquire lock and activate
changes option is enabled in your admin console Preferences.

Note:

k) Click Deployments in the Domain Structure list. Your newly deployed Web Application
appears in the Deployments list.

l) For Case 1, make sure that your Interstage BPM Server is running because you will not be
able to start ibpmconsole (webserviceproxy) if it is not running.

m) Check the Selection box of ibpmconsole (webserviceproxy), then select Servicing all
requests from the Start drop-down list to the Web application.

n) Click Yes to confirm that you want to start the selected Web applications. A page indicating
that the deployment has started will appear.

11. Start the Interstage BPM Server and Console. Refer the following topics:
• Starting Interstage BPM Server on page 44
• Starting Interstage BPM Console and Tenant Management Console on page 45

10.6 Additional Steps for Form Styles while Migrating from
Interstage BPM Console 11.1
Versions of Interstage BPM Console later than v11.1 allow changing the look and feel of Interstage
BPM Console forms using Interstage BPM Console itself. If you are migrating from Interstage BPM
Console 11.1, and you were using custom stylesheets for either:
• tenants (stylesheet placed under //<console

WAR>/tenant/<tenantName>/web/styles/custom.css or //<console
WAR>/web/styles/custom.css), OR

• applications (stylesheet placed under //<console
WAR>/tenant/<tenantName>/apps/<appName>/web/styles/customTheme.css)

after migration, ensure you define form-specific style classes in the custom CSS files.

10.7 Additional Steps for Interstage BPM Console

10.7.1 Deleting Interstage BPM Console
In version 11.2.1 of Interstage BPM, Interstage BPM Console is always deployed with Interstage
BPM Server. Therefore if you do not want to work with Interstage BPM Console you can un-deploy
it from your application server.
On WebLogic:
1. Access the Administration Console of WebLogic Server, and in the Domain Structure tree, select

Deployments.
2. In Summary of Deployments, in the Control tab, select the InterstageBPMConsole checkbox.
3. Click Delete.
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10.7.2 Updating System Properties for Web Server Port
If you changed your WebServer port from default value, you need to change the following System
properties.
• ServerBaseURL
• ServerEmailBaseURL
You can update these values via the Interstage BPM Tenant Management Console or Import/Export
property commands. How to change properties using Tenant Management Console is explained in
the Interstage BPM Tenant Management Console Online Help. Details of using import/export
commands are described in the Interstage BPM Server Administration Guide.
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Appendix A: Security
Interstage BPM can be set to two security levels: Demo Mode and Security Mode. Demo Mode is
useful while key members of your work team learn the features of the software. Later, Security Mode
provides a stable and controlled environment for implementing Interstage BPM across your company.

A.1 Interstage BPM Operation Model
It is assumed that Interstage BPM is used in an organizational Intranet. In most situations, end-users
will work with Interstage BPM applications via a firewall, administrators, however, will be using the
server segment.
End-users do not need to run applets or other clients requiring the Interstage BPM model. This means
that the only port that needs to be opened in the firewall is the standard HTTPS port (443) and the
Web Server in the server segment.
The following diagram depicts a deployment situation where Interstage BPM applications are used
via a firewall. It also shows possible security threats – these are described in more detail in the
subsequent table.

Figure 29: Interstage BPM Operation Model

The following table lists the possible security threats as well as possible solutions:
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SolutionThreat#

Use SSL.Message interception(1)

Make sure that your administrators are properly trained and
certified, and that the firewall, the Web Server, the Interstage
BPM Server, the Database Server and the Directory Server are
configured correctly.

Wrong configuration(2)

Use firewall configuration to block illegitimate requests.Denial of service(3)

Use secure cookies if you are using cookies for session
management.

Cookie wiretap(4)

Keep the Web Server, Interstage BPM Server, the Directory
Server and the Database Server machines in a secure location.

Internal message
interception

(5)

Keep the Web Server, Interstage BPM Server, Directory Server
and Database Server machines in a secure location. Set the
operating system/database permissions such that file/database
access is possible only by authorized people. Take special care
for the directories/database of Interstage BPM, Interstage
Application Server, Active Directory and Oracle.

Alternation of config file or
database

(6)

All guessed passwords should be changed to something that
is less vulnerable. Passwords should not be proper nouns (e.g.,
a person's name), a word found in a dictionary or the same
string as the user name.
Ideally, a password should contain a minimum of 6 characters
in a mixture of upper case, lower case, numeric digits and other
characters. In addition, it should not contain more than two
identical consecutive characters and more than two ascending
or descending consecutive characters.

Password susceptible to
brute force attack

(7)

Install under the condition that no one is around you.Password peep during the
installation

(8)

As a rule, always use anti-virus software.Virus or worm injection(9)

A.2 Password Encryption
The Interstage BPM Deployment Tool encrypts the passwords entered during deployment and writes
the encrypted passwords into the database.
The Interstage BPM Server decrypts all passwords at startup. If decryption fails, a warning message
is printed in the Trace.log file.
If you need to change the user/passwords after deployment, an Encryption Utility is provided so that
you can encrypt the passwords and overwrite them in the server's configuration. The Encryption
Utility does not provide for decryption of passwords. It can only be used for encryption.
Initially, a default key is used to encrypt and decrypt the passwords. If you want to use a different
key for security reasons, you must add this key to the server's configuration. The default key is not
published; it is hardcoded in the server code.
The Encryption Utility provided is:
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com.fujitsu.iflow.utilities.TextEncrypter.class

To call the Encryption Utility, use the encryption script located in <Interstage BPM Server
Installation Directory>/client/samples/configuration:
• On Windows: EncryptPassword.bat
• On UNIX: EncryptPassword.sh

Encrypting a Password With the Default Key
To encrypt a password with the default key, run the script with the following option:
On Windows: EncryptPassword.bat -e "<TextPassword>"

On UNIX: EncryptPassword.sh -e "<TextPassword>"

Make sure to enclose the password and the encryption key in double quotes. Otherwise,
the encryption process might fail. As double quotes are delimiters, do not use double quotes
in the encryption key.

Note:

Encrypting Passwords With a New Key
You are recommended to encrypt your passwords with your own key.
To encrypt a single password with a new key, run the script with the following options:
On Windows: EncryptPassword.bat -e "<TextPassword>" "<Key>"

On UNIX: EncryptPassword.sh -e "<TextPassword>" "<Key>"

If a key other than the default key is used, it should contain more than 24 characters.
Make sure to enclose the password and the encryption key in double quotes. Otherwise,
the encryption process might fail. As double quotes are delimiters, do not use double quotes
in the encryption key.

Note:

During startup of the Interstage BPM Server, the key needs to be present in the server's configuration.
Therefore, before starting the server, use the configuration export and import scripts to add the
following parameter to the server's configuration:
EncryptionKey=<Key>

For details on the procedure, refer to section Using the Configuration Export and Import Scripts on
page 83. For security reasons, the key can be removed again from the configuration file that you
imported into the database.
Alternatively, you can encrypt all passwords in the configuration file at the same time before importing
it into the database. To do this, substitute all passwords in the configuration file with actual text
passwords and encrypt the configuration file by running the script with the following options:
On Windows: EncryptPassword.bat -f "<Path of Configuration File>" "<Key>"

On UNIX: EncryptPassword.sh -f "<Path of Configuration File>" "<Key>"

Make sure to enclose the file path and the encryption key in double quotes. Otherwise, the
encryption process might fail. As double quotes are delimiters, do not use double quotes
in the encryption key.

Note:

The following parameters in the configuration file are encrypted using this method:
• DBALoginpassword

• LDAPAccessUserPassword
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• MetadataRepositoryPassword

• ServerPassword

• SMTPPassword

• SWAPLinkagePassword

• UDDIPublisherPassword

Example
Use the following command to encrypt all passwords in the configuration file at the same time.
On Windows: EncryptPassword.bat -f
"C:\SomeDirectory\MyServerConfiguration.properties" "EWAERJQ23FIQ0J22"

On UNIX: EncryptPassword.sh -f "/SomeDirectory/MyServerConfiguration.properties"
"EWAERJQ23FIQ0J22"

A.3 Using Demo Mode and Security Mode
Interstage BPM can be set to two security levels: Demo Mode and Security Mode. Demo Mode is
useful while key members of your work team learn the features of the software. Later, Security Mode
provides a stable and controlled environment for implementing Interstage BPM across your company.
Demo Mode restricts access to Interstage BPM in two ways:
• Only the person who is assigned a work item may make choices about it, thus advancing the

process to the next work item - or completing it.
• Only members of the AdminRole can access administration functions in the Interstage BPM

Console.
All Interstage BPM users can experiment with all of Interstage BPM functions, including creating and
editing process definitions and process instances.
In Security Mode, access to process definitions, process instances, and work items are restricted
to the specific people who need to use them. The following are examples of people who need to use
them:
• Only members of the Role specified in the TemplatePublishers parameter of the Interstage

BPM Server can create new process definitions.
• Only the process instance owners, current assignees, and Interstage BPM Administrators can

view any specific process instances. (Current assignees are those who have active task
assignments. This does not include people who will have task assignments later in the process.)

• Only the process instance owners, current assignees, and Interstage BPM Administrative Users
can edit their specific process instances. This means they can change User Defined Attributes
and add or delete attachments. However, they are not allowed to edit the process structure.

To set up Security Mode:
• Add the following parameters to the server configuration:

SecuritySwitch=true

This setting enables Security Mode.
TemplatePublishers =<Registered Role>

This Role must be registered in Interstage BPM's local group store or in your Directory Service.
For example, if you have defined a Role of pubRole, you would type
TemplatePublishers=pubRole. Be aware that this key takes effect only if the Security Mode is
switched on.
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For information on how to add parameters, refer to section Using the Configuration Export and
Import Scripts on page 83.

A.4 Configuring SMTP Authentication for Use with Interstage
BPM

Only a System Administrator should perform these instructions.Note:

If you required SMTP Authentication for logging in to Interstage BPM, use the following instructions:
1. Set up an email server and enable SMTP Authentication.
2. Add the following parameters to the server configuration:

SMTPServerHost=<Email Server Host Name>

SMTPUserName=<User Name for SMTP Authentication>

SMTPPassword=<Password for SMTP authentication>

For details on the procedure, refer to section Using the Configuration Export and Import Scripts
on page 83.

3. Design a process definition to test the email feature.
Refer to the Interstage Business Process Manager Studio User's Guide for information on how
to design process definitions.

If the SMTPUserName or SMTPPassword are set correctly, the email will be accepted by the email
server. If neither the SMTPUserName nor SMTPPassword values are blank, Interstage BPM will use
the SMTP authentication feature.

A.5 Using the Configuration Export and Import Scripts
Prerequisite: The database server is running.

Interstage BPM comes with configuration export and import scripts that allow you to change the
server configuration. You can use these scripts to add parameters that are not present in the
configuration or remove parameters from the configuration. If the server fails to start or denies login
due to configuration errors, you can use the scripts to import a working configuration into the database.
You can add or edit both System as well as Tenant properties using the export and import scripts.
For more information about System and Tenant properties, refer the Interstage BPM Server
Administration Guide.
The Interstage BPM Server is not required to be running for the configuration export and import
scripts to be used.
To use the configuration export and import scripts:
1. Export the server configuration by running the export script located in <Interstage BPM Server

Installation Directory>/server/deployment/bin:
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Configuration Export ScriptOperating System

• For System Properties:
exportProperties.bat <File Name> <Database User Name>
<Password>

Example:
exportProperties.bat MyServerConfiguration.properties
SomeUserName SomePassword

• For Tenant Properties:
exportProperties.bat <File Name> <Database User Name>
<Password> <TenantName>

Note that <TenantName> is case-sensitive.
Example:
exportProperties.bat MyServerConfiguration.properties
SomeUserName SomePassword Default

Windows

• For System Properties:
exportProperties.sh <File Name> <Database User Name>
<Password>

Example:
exportProperties.sh MyServerConfiguration.properties
SomeUserName SomePassword

• For Tenant Properties:
exportProperties.sh <File Name> <Database User Name>
<Password> <TenantName>

Note that <TenantName> is case-sensitive.
Example:
exportProperties.sh MyServerConfiguration.properties
SomeUserName SomePassword Default

UNIX

For <File Name>, specify the file name and, optionally, the path of the configuration file to be
generated. If you do not specify a path, the configuration file is written to the current directory.
For <Database User Name> and <Password>, specify the database user account that you defined
during deployment of the Interstage BPM Server.

Before you make any changes to the configuration file, create a copy of the configuration
file you exported as a back-up. In case you make errors while editing parameters and import
the file, Interstage BPM Server may not be able to start or errors may occur at runtime. In
such a case you can use the back-up file which contains a working configuration.

Note:

2. Make the required changes in the generated configuration file.
If you want to add parameters, use the following syntax:
<Parameter Name>=<Parameter Value>
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Note: • Parameter names and values are case sensitive.
• Any backslashes "\" or colons ":" used in parameter values must be escaped by

backslashes. For example, a server address is specified like this:
ibpmhost\:49950

• Some configuration parameters have a <Hostname> or <Hostname>.<Servername> suffix
appended to their names. These suffixes are automatically removed during the export
and are automatically appended during the import. Do not add these suffixes to the
parameter names.

Passwords in the generated configuration file are encrypted for security reasons. If you change
a password, you are recommended to encrypt it before importing the configuration file. Passwords
are not automatically encrypted during the import. For details on how to encrypt passwords, refer
to section Password Encryption on page 80.

3. Import the updated configuration file into the database by running the import script located in
<Interstage BPM Server Installation Directory>/server/deployment/bin:
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Configuration Import ScriptOperating System

• For System Properties:
importProperties.bat <File Name> <Database User Name>
<Password>

Example:
importProperties.bat MyServerConfiguration.properties
SomeUserName SomePassword

• For Tenant Properties:
importProperties.bat <File Name> <Database User Name>
<Password> <TenantName>

Note that <TenantName> is case-sensitive.
Example:
importProperties.bat MyServerConfiguration.properties
SomeUserName SomePassword Default

Windows

• For System Properties:
importProperties.sh <File Name> <Database User Name>
<Password>

Example:
importProperties.sh MyServerConfiguration.properties
SomeUserName SomePassword

• For Tenant Properties:
importProperties.sh <File Name> <Database User Name>
<Password> <TenantName>

Note that <TenantName> is case-sensitive.
Example:
importProperties.sh MyServerConfiguration.properties
SomeUserName SomePassword Default

UNIX

For <File Name>, specify the file name and, if required, the path of the updated configuration
file. You need to specify the path if the configuration file is not located in the current directory.
For <Database User Name> and <Password>, specify the database user account that you defined
during deployment of the Interstage BPM Server.

4. In a cluster installation, each server node must be configured individually. Therefore, repeat steps
1-3 for the other server nodes.

5. Restart the Interstage BPM Server for the changes to take effect.
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Appendix B: Silent Mode Installation
A Silent Mode installation is a non-interactive type of installation, i.e. you start the installation program
and Interstage BPM is installed. If you have to perform multiple installations of Interstage BPM, and
the installations are essentially the same, you might want to consider installing Interstage BPM in
Silent Mode as you can save a significant amount of time.

How It Works
Silent Mode installations involve the use of an installation script. You perform the first installation
interactively using a special installation option that records the installation into an installation script
in ASCII (text) format. You then run subsequent installations in silent mode using this script. Minor
installation variations can be handled by editing the script.

B.1 Setting Up a Silent Mode Installation of Interstage BPM
To set up a Silent Mode Installation:
1. Create a new directory on your computer.
2. Copy the following files from the engine directory on your CD-ROM to the directory that you

created on your computer:
• setup.jar

• setupwin32.exe on Windows
• setupSolaris.bin on Solaris
• setupLinux.bin on Linux

3. Open a Command Prompt window and navigate to the directory on your computer containing the
copied files.

4. Start the installation program for Interstage BPM by entering the following command:
On Windows:
setupwin32.exe /r /f1"<Absolute Installation Script Path>\<Installation Script
Name>"

In the following example, RMI is the directory containing the copied files and record-install.iss
is the name of the installation script to be recorded:
C:\RMI> setupwin32.exe /r /f1"C:\RMI\record-install.iss"

The installation script for Windows is created in a .iss (and not .txt) file.Note:

On Solaris:
./setupSolaris.bin -options-record <Installation Script>

In the following example, RMI is the directory containing the copied files and record-install.txt
is the name of the installation script to be recorded:
/RMI> ./setupSolaris.bin -options-record record-install.txt

On Linux:
/RMI> ./setupLinux.bin -options-record record-install.txt
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If you receive an error while launching the installation program on Linux, it is possible that
some essential packages are missing from the Linux machine. For details about mandatory
packages for Linux, refer Preparation for Installing Interstage BPM on Linux Environments
on page 16. After installing mandatory packages, retry launching the Interstage BPM
installation program for Linux.

Note:

This command starts a normal mode installation of Interstage BPM and records the installation
choices that you make. As the installation program runs, use the instructions in chapter Installing
and Deploying Interstage BPM Server and Console on page 25.
At the end of installation, the installation choices are written to the installation script. In the example,
the installation script record-install.txt (record-install.iss for Windows) is created in
the RMI directory. You can now use the installation script to install Interstage BPM on other
computers in Silent Mode.

B.2 Installing Interstage BPM in Silent Mode
Prerequisite: You have set up your Silent Mode installation as instructed in section Setting Up a
Silent Mode Installation of Interstage BPM on page 87.

To install Interstage BPM using Silent Mode:
1. Create a directory on the computer where you want to install Interstage BPM in Silent Mode. In

the example below, RMI is used as the directory's name.
2. Copy the following files from the computer where you recorded the installation script to the directory

that you created in the previous step:
• the installation script that you recorded, e.g. record-install.txt
• setup.jar

• setupwin32.exe on Windows
• setupSolaris.bin on Solaris
• setupLinux.bin on Linux

3. Make a note of the drive and directory to which you copied the files.
4. Open the installation script in a text editor and make any changes necessary to make it run

properly in the different environment. Refer to section Silent Mode Installation Options on page
89 for allowed changes.
For example, you might have your J2SE Development Kit (JDK) installed on a different drive and
in a different directory than on the computer where you recorded the installation script. You must
search for that path and change it to the path used by the computer on which you are running
the silent mode installation.

5. Save the changes made to your installation script.
6. Open a Command Prompt window and navigate to the directory that contains the installation

script.
7. Install Interstage BPM in Silent Mode with the following command:

On Windows:
C:\RMI> <Absolute Path>\setupwin32.exe /s /f1"<Absolute Installation Script
Path>\<Installation Script Name>" /f2"<Absolute Installation Log File
Path>\<Installation Log File Name>"

On Solaris:
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/RMI> ./setupSolaris.bin -options "<Absolute Path>/record-install.txt" -silent

On Linux:
/RMI> ./setupLinux.bin -options "<Absolute Path>/record-install.txt" -silent

This procedure can be repeated for all of your Interstage BPM installations.

B.3 Silent Mode Installation Options
The Silent Mode installation script is a text file that you record while performing the first installation.

Only use the installation script for the type of installation that you recorded. Do not add or
delete parameters. Otherwise, your installation script might not work properly.

Note:

You can customize the installation script to make it run properly in a different environment. For
example, you might have your J2SE Development Kit (JDK) installed on a different drive and in a
different directory than on the computer where you recorded the installation script.

Parameter Description
The following table lists the parameters that occur in the installation script. All parameter values have
to be enclosed in double quotes. A short description of the parameters is also provided. For detailed
information about the parameters, refer to section Installing Interstage BPM on page 27.

DescriptionSample ValueParameter Name

Absolute path to the installation
directory of the Interstage BPM.

On Windows:
"C:\Fujitsu\InterstageBPM"

On UNIX: "/opt/FJSVibpm"

On Windows: szDir (located
below SdAskDestPath2)
On UNIX: -W
bean1.destinationPath

Absolute path to the top-level
directory of the J2SE
Development Kit (JDK)
installation.

On Windows: "C:\j2sdk"
On UNIX: "/usr/java"

On Windows: szDir (located
below SelectDir)
On UNIX: -W bean11.jdkHome
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DescriptionSample ValueParameter Name

Specifies whether the installation
program launches the
Deployment Tool in graphical
mode at the end of installation.
"A": The installation program
launches the Deployment Tool
in graphical mode. This option
does not make sense when
running a silent mode installation
because it requires some user
interaction after installation.
"": The installation program
does not launch the Deployment
Tool.
Like the installation program, the
Deployment Tool can be run in
Silent Mode. For details, refer to
appendix Silent Mode
Deployment and Undeployment
on page 91.

""On Solaris: -W
bean2223.deploymenttool

On Linux: -W
bean22233.deploymenttool

(This parameter does not exist
for Windows)

Example
On Windows, since no parameter exists to control launch of Deployment Tool in graphical mode,
even if you perform a silent install, the Deployment Tool is not launched in graphical mode at the
end of silent installation. For example, the following script performs a new installation of the Interstage
BPM, but the Deployment Tool is not launched at the end of silent installation.

...
[{ ID }-SdAskDestPath2-0]
szDir=C:\Fujitsu\InterstageBPM
[{ ID }-SelectDir-0]

...
szDir=C:\j2sdk

...

On UNIX-based systems, the following sample script performs a new installation of the Interstage
BPM without launching the Deployment Tool at the end of installation.
Sample script for Solaris:

-W bean1.destinationPath="opt/FJSVibpm"
-W bean11.jdkHome="/usr/java"
-W bean2223.deploymenttool=""

Sample script for Linux

-W bean1.destinationPath="opt/FJSVibpm"
-W bean11.jdkHome="/usr/java"
-W bean22233.deploymenttool=""
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Appendix C: Silent Mode Deployment and Undeployment
Like the installation program, the Deployment Tool can be run in Silent Mode. Running the Deployment
Tool in silent mode allows you to deploy or undeploy Interstage BPM Server without user interaction.
This is an efficient way to perform multiple deployments or undeployments if the operations are
essentially the same.
Silent Mode deployments and undeployments require the use of a Silent Mode script. You perform
an interactive deployment or undeployment using a special option that records your choices into a
Silent Mode script. You then run subsequent deployments/undeployments in Silent Mode using this
script. Minor operation variations can be handled by editing the script.

C.1 Setting Up Silent Mode Operation
To set up a Silent Mode operation:
1. Start the Deployment Tool with the -generateSilent option.

From <Interstage BPM Installation Directory>/server/deployment/tool execute the
following command:

Startup ScriptOperating System

run_windows.bat -generateSilent (for 32bit
Deployment Tool)
run_windows_x64.bat -generateSilent (for
64bit Deployment Tool)

Windows

run_solaris.sh -generateSilentSolaris

run_linux.sh -generateSilent (for 32bit
Deployment Tool)
run_linux_x64.sh -generateSilent (for
64bit Deployment Tool)

Linux

2. Choose the operation you want to perform (Server Instance Setup / Server Instance Removal).

The Upgrade and External setup options are not supported in silent mode.Note:

3. Walk through the configuration steps for the operation you selected until you reach the Setup
Confirmation screen .

4. Click Next to start the selected operation.
Your configuration choices are written to a Silent Mode script named silent_<Date>. The script
is located in <Interstage BPM Server Installation
Directory>/server/deployment/resources.

It is recommended you rename the Silent Mode script because it will be overwritten if you
regenerate it.

Note:

You can now use the script to perform the recorded operations on other computers in Silent Mode.
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C.2 Running Silent Mode Operations
Prerequisite: You have created a Silent Mode script as instructed in section Setting Up Silent Mode
Operation on page 91. Also, Interstage BPM is already installed on your computer.

To run the Deployment Tool in Silent Mode:
1. Copy the Silent Mode script that you recorded to the computer where you want to run the

Deployment Tool in Silent Mode.
You can copy the script to a directory of your choice.

2. Open the Silent Mode script in a text editor and make any changes necessary to make it run
properly in the different environment. Refer to section Silent Mode Deployment Tool Options on
page 92 for allowed changes.
For example, you might have your database installed on a different drive and in a different directory
than on the computer where you recorded the script. You must search for that path and change
it to the path used by the computer on which you are running the silent mode deployment.

3. Open a Command Prompt window and navigate to the directory <Interstage BPM Server
Installation Directory>/server/deployment/tool.

4. Execute the following command:

Startup ScriptOperating System

run_windows.bat -silentmode <Silent
Mode Script> (for 32bit Deployment Tool)
run_windows_x64.bat -silentmode <Silent
Mode Script> (for 64bit Deployment Tool)

Windows

run_solaris.sh -silentmode <Silent Mode
Script>

Solaris

run_linux.sh -silentmode <Silent Mode
Script> (for 32bit Deployment Tool)
run_linux_x64.sh -silentmode <Silent
Mode Script> (for 64bit Deployment Tool)

Linux

For <Silent Mode Script>, specify the absolute path of your script.
The Deployment Tool will run in silent mode and execute the options you chose while recording
the script.

C.3 Silent Mode Deployment Tool Options
The Silent Mode script is a text file that you record while running the Deployment Tool in interactive
mode. The contents of the Silent Mode script depends on the type of operation that you record. There
are different types of operations; each type has its own set of parameters:
• Server/Console instance setup without configuring the database (deployment)
• Server/Console instance setup including database configuration (deployment)
• Server/Console instance removal (undeployment)
For each type of operation, there are additional variations depending on the application server,
database and Directory Service you are using.
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Only use the Silent Mode script for the type of operation that you recorded.Note:

You can customize the script to make it run properly in a different environment. For example, you
might have your database installed on a different drive and in a different directory than on the computer
where you recorded the script.
The following tables list the parameters that you may change in the script. A short description of the
parameters is also provided. Parameters listed below for the application server are applicable
for both deployment as well undeployment, unless specifically mentioned otherwise.

Note: • Only change parameters that are described below. Do not change any other parameters.
Do not add or delete parameters. Otherwise, your script might not work properly.

• Any backslashes "\", colons ":" or equal signs "=" used in parameter values must be
escaped by backslashes. For example, a server address is specified like this:
ibpmhost\:49950

WebLogic Application Server Parameters (for Deployment and Undeployment)

DescriptionSample Value (without
spaces)

Parameter

Port number of your WebLogic
domain's Administration Server.

7001appserver_administration_server_port

Host name of your WebLogic
domain's Administration Server.
Usually the value is 'localhost'.

localhostappserver_administration_server

User name of the administrator
for your WebLogic
Administration Server.

weblogicappserver_admin_username

Password of the user specified
in appserver_admin_username.

weblogic1appserver_admin_password

Absolute path of the WebLogic
JAR file weblogic.jar.

On Windows:
• C\:\\Oracle\\Middleware\\

wlserver_10.3\\server\\

lib\\weblogic.jar

On UNIX:
• /opt/oracle/

middleWare/wlserver_10.3/

server/lib/weblogic.jar

appserver_weblogic_jar

Name of the Interstage BPM
Server.

IBPMServerappserver_ibpm_servername
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DescriptionSample Value (without
spaces)

Parameter

Port number used by the
Interstage BPM Server.
Note: Available only during
deployment

49950as_ibpm_server_port

Database Parameters – Microsoft SQL Server

DescriptionSample Value (without
spaces)

Parameter

User name for a
non-administrative database
user account.

ibpmuserdb_ibpm_user_name

Password for the
non-administrative database
user account.

ibpmuserpassworddb_ibpm_password

Database server name or IP
address. This parameter is
necessary only for remote
database.

<database server name>db_host

Port on which Microsoft SQL
Server is running.

1433db_port

Password for the administrative
database user account.

adminpassworddb_adminpassword

Absolute path of the JDBC
driver.
For the exact version of the
JDBC driver supported, refer the
Release Notes.

C\:\\MicrosoftSQLServer2005JDBCDriver
\\sqljdbc_2.0\\enu\sqljdbc4.jar

db_jdbc_library_path

Absolute path to the top-level
directory of your Microsoft SQL
Server installation.

C\:\\Program Files\
\Microsoft SQL Server

db_database_home

Username for the administrative
database user account. Usually
sa for Microsoft SQL Server.

sasql_db_admin_username

Absolute path to the directory
where the Interstage BPM
database resides.

C\:\\Program Files\
\Microsoft SQL Server\
\MSSQL.1\\MSSQL\\Data

sql_db_data_files_dir
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Database Parameters – Oracle

DescriptionSample Value (without
spaces)

Parameter

User name for a
non-administrative database
user account.

ibpmuserdb_ibpm_user_name

Password for the
non-administrative database
user account.

ibpmuserpassworddb_ibpm_password

Database server name or IP
address. This parameter is
necessary only for remote
database.

<database server name>db_host

Port number of the database1521db_port

Absolute path of the Oracle
JDBC driver.
For the exact version of the
JDBC driver supported, refer the
Release Notes.

On Windows:
C\:\\ojdbc\\Driver11.1.0.7\\ojdbc6.jar

On UNIX:
/opt/ojdbc/driver11.1.0.7/ojdbc6.jar

db_jdbc_library_path

Absolute path to the top-level
directory of your Oracle
installation.

On Windows:
C\:\\app\\Administrator\\product\\11.2.0\\db_1

On UNIX:
/opt/oracle/product/11.2.0/db_1

db_database_home

Password of the SYSTEM useroracleadminpassworddb_admin_password

Connection identifier for the
Oracle database

ORCLdb_instance_name

Absolute path to the directory
where the Interstage BPM
database resides.

On Windows:
C\:\\app\\Administrator\\
product\\11.2.0\\oradata\\orcl

On UNIX:
/opt/oracle/product/11.2.0/oradata/orcl

db_data_file_location

Interstage BPM System Administrator (Super User)

DescriptionSample Value (without
spaces)

Parameter

User name of the Interstage
BPM System Administrator
(Super User)

ibpm_server1super_user
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DescriptionSample Value (without
spaces)

Parameter

Password of the Interstage BPM
System Administrator (Super
User)

ibpm_server1super_user_password

Directory Service Parameters

DescriptionSample ValueParameter

Host name or IP address of the
computer hosting the Directory
Service.

myhostLDAPServer

Directory Service Key.dc\=fujitsu,dc\=comLDAPDBSuffix

Directory Service Organizational
Unit.

ou\=GroupsLDAPGroups

Directory Service port.389LDAPPort

Interstage BPM Tenant Owner

DescriptionSample Value (without
spaces)

Parameter

User name of Tenant Owner of
the default tenant.

ibpm_server1LDAPAccessUserID

Password of Tenant Owner of
the default tenant.

ibpm_server1passwordLDAPAccessUserPassword

Interstage BPM Environment

DescriptionOptionsParameter

Application server type for
Interstage BPM deployment.

WebLogic for WebLogicappserver_selected

Directory server type0: Local user management
1: Oracle Directory Service
3: Active Directory

DirectoryService

Database server type for
Interstage BPM deployment

Oracle for Oracle11g/10g
SQLServer for Microsoft SQL
Server

database_selected

Configuration for Interstage BPM
database

0: create new database
1: use existing database

database_creation_selection
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Appendix D: Silent Mode Uninstallation
Similar to silent undeployment, you can also uninstall Interstage BPM in silent mode, without user
interaction. This is helpful for multiple, similar uninstallations.

Unlike in the Interstage BPM interactive uninstall functionality (using the Graphical User
Interface), in Silent Mode you cannot undeploy and uninstall together in one go. In Silent
Mode, you need to do these actions separately with two different scripts.

Note:

D.1 Setting Up a Silent Uninstall
This setup is required only for Windows. For other platforms, no setup is required; you can
directly uninstall Interstage BPM silently using the information in section Uninstalling
Interstage BPM in Silent Mode on page 97.

Note:

Pre-requisites: You have already undeployed Interstage BPM.
On Windows, set up a silent uninstallation as follows:
1. Record your choices from the interactive uninstallation into an uninstallation script.

a) From the Command Prompt, run the following command: "C:\Program Files\InstallShield
Installation Information\{DFC70E37-68E7-469C-A253-9ED7BB3BCD23}\setup.exe"
-runfromtemp -l0x0009 -removeonly -r -f1"Absolute Uninstallation
ScriptPath>\<Uninstallation Script Name>"
For example:
• Run the following command: "C:\Program Files\InstallShield Installation

Information\{DFC70E37-68E7-469C-A253-9ED7BB3BCD23}\setup.exe" -runfromtemp
-l0x0009 -removeonly -r -f1"C:/Temp/record-uninstall.iss"

Note that the recorded script should be a *.iss file.

b) On the first uninstall screen that comes up (Deployment Tool Options Screen), ensure you
select the Do not launch Deployment Tool option.

c) Click though the remaining uninstall screens to finish recording the script.

D.2 Uninstalling Interstage BPM in Silent Mode
Pre-requisite: On Windows, ensure you have completed setting up silent mode uninstallation.
To uninstall Interstage BPM using Silent Mode:
1. On Windows:

a) Copy the uninstall script you recorded earlier, on to the machine where you intend to uninstall
Interstage BPM silently.

b) From the Command Prompt, run the following command: "C:\Program Files\InstallShield
Installation Information\{DFC70E37-68E7-469C-A253-9ED7BB3BCD23}\setup.exe"
-runfromtemp -l0x0009 -removeonly -s -f1"Absolute Uninstallation Script
Path>\<Uninstallation Script Name>"

2. On UNIX: From the Command Prompt, navigate to <Interstage BPM Server Installation
Directory>/_uninst and run the following command: uninstall.sh -silent.
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Appendix E: Running Interstage Business Process
Manager in Solaris Containers

The Solaris "container" feature enables you to run several Solaris servers with the same version of
the Solaris operating system on the same physical machine. Each of the Solaris servers configured
in this way is called a "container" with the following properties:
• individual, separate IP address
• individual server name
• individual file system
• individual or shared resource pool
For instructions on setting up Solaris containers, refer to the Solaris product documentation. Below,
you find a sample setup.

Sample
This section lists all commands that need to be called on a Solaris 10 machine in order to set up a
container with the following settings:
• Container name (host name): IBPM_Test
• IP address: 11.1.111.111
• File system: default
• Additional devices: none
• Project: myIBPMProject
• Resource pool: minimum 2 and maximum 4 CPUs
The basic Solaris installation consists of exactly one container (or zone): the global zone. Every
additionally installed zone is called local zone or container. Proceed as follows:
Step 1: Configuring the container
1. Create a root directory for the IBPM_Test container:

mkdir -p /export/zones/IBPM_Test

2. Set the user permissions:

chmod 700 /export/zones/IBPM_Test

3. Create and configure the container:

zonecfg -z IBPM_Test
create
set zonepath=/export/zones/IBPM_Test
set autoboot=true
add net

set address=11.1.111.111
set physical=hme0

end
verify
commit
exit
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4. Install the container:

zoneadm -z IBPM_Test install

5. Boot the container:

zoneadm -z IBPM_Test boot

6. Login to the container:

zlogin -C IBPM_Test

7. Proceed with answering the default questions for the container settings when you log in for the
first time.

Step 2: Setting up ssh connectivity for the container
1. Edit the /etc/ssh/sshd_config file:

vi /etc/ssh/sshd_config

and set the PermitRootLogin to yes.

2. Restart the container:

init 1
init 3

After having finished the initial setup, leave the current prompt by typing ~. (currently you are logged
in as the root of the global container). All subsequent actions can be performed if you log in as root
user via ssh.
Step 3: Setting up a resource pool and binding it to the container
1. Create a processor set:

poolcfg -c 'create pset ibpm (uint pset.min=2; uint pset.max=4)'

2. Create the resource pool:

poolcfg -c 'create pset ibpmpool (string pool.scheduler="FSS")'

3. Associate the processor set to the pool:

poolcfg -c 'associate pool ibpmpool (pset ibpm)'

4. Enable the settings:

pooladm -c

5. Verify the settings:

poolcfg -dc info

Interstage BPM Server and Console Installation Guide (WebLogic Server) 99

Appendix E: Running Interstage Business Process Manager in Solaris Containers



Step 4: Binding the pool to the container
1. Set the pool for the container:

zonecfg -z IBPM_Test set pool=ibpmpool

2. Bind the pool to the container:

poolbind -p ibpmpool -i zoneid IBPM_Test

3. Exit the prompt.
Step 5: Setting up the project for the container
1. Log on to the local container IBPM_Test as user root.
2. Create a project myIBPMProject for user root:

projadd -c "IBPM default project" -U root myIBPMProject

3. Set the maximum shared memory for the project:

projmod -sK "project.max-shm-memory=(priviliged,521M,deny)" myIBPMProject

4. Set the CPU shares for the project:

projmod -sK "project.cpu-shares=(privileged,100,none)" myIBPMProject

Step 7: Starting Interstage Business Project Manager
1. To start Interstage Business Process Manager and apply the restrictions set in the previous steps:

newtask -p myIBPMProject

All activities that will be started subsequent to the above command will be subject to the set resource
restrictions and be started for / in the myIBPMProject of the IBPM_Test container.
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Appendix F: Clustering, Load Balancing, and Failover
This appendix provides you with an effective means of increasing the scalability and reliability of
your Interstage Business Process Manager system. Configuring your system for load balancing can
increase scalability. Configuring your system for failover can increase reliability.
This appendix provides guidelines for setting up a cluster of Interstage BPM Servers. It also provides
guidelines for configuring that cluster for load balancing and failover.
In an Interstage BPM Cluster, multiple Interstage BPM Servers are deployed to work in concert with
each other. In other words, they work together as a unit. The default Interstage BPM Cluster is
configured for load balancing in a round-robin configuration and for failover. For Interstage BPM
Clusters in a round-robin configuration, requests sent to the cluster are distributed evenly among
the servers in the cluster. If the cluster is configured for failover, a working server in the cluster
automatically "takes over for" a server in the cluster that has just failed for some reason.

Ensure that all machines that you plan to include in a cluster are in the same Time Zone,
and the difference between their system times is not more than 5 minutes.

Note:

F.1 Setting Up an Interstage BPM Cluster on WebLogic
Application Server
To set up an Interstage BPM Cluster, you must first configure a cluster of Interstage BPM Servers,
and then connect that cluster to all of the Interstage BPM components in the same manner that they
were connected to a single Interstage BPM Server. Setting up the cluster consists of the following
major steps:
1. Preparing the cluster setup. This involves preparing the database, the application server and

Interstage BPM Server.
2. Configuring environment variables
3. Configuring Interstage BPM for the cluster by running a script
4. Configuring the Shared Resource Root
5. Updating the Interstage BPM Server configuration files
6. Updating the Interstage BPM Client configuration
7. Updating environment variables and server startup scripts
8. Importing the Interstage BPM Server configuration files
9. Starting the cluster
10. Implementing failover if you require this feature
The sample cluster used to illustrate the instructions in this section is deployed on two computers.
The computer with hostname svmd2 is the computer on which the WebLogic Administration Server
is running. svmdapp5 is the other computer in the sample cluster. The cluster is configured to run a
standard load-balancing algorithm known as round-robin. A file server is used for storing documents
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that need to be accessed by all cluster nodes, for example attachments to process instances. The
following figure shows the sample system.

Figure 30: Sample Cluster

The next sections provide step-by-step instructions on how to set up the cluster.

F.1.1 Preparing the Cluster
Prerequisite: All cluster nodes can reach each other via IP multicast. For you to check whether
multicasts are available in the target environment, perform the following steps:
1. Run the following script on each node of the cluster:

Multicast Receiver ScriptOperating System

startMulticastReceiver.batWindows

startMulticastReceiver.shUNIX

This script file is located in <Interstage BPM Server Installation
Directory>/server/deployment/bin.

2. Run the following script on one node of the cluster and check whether all nodes in the cluster are
receiving the multicasts:

Multicast Sender ScriptOperating System

startMulticastSender.batWindows

startMulticastSender.shUNIX

This script file is also located in <Interstage BPM Server Installation
Directory>/server/deployment/bin.
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3. Stop the execution of the multicast sender script. If there are any remaining nodes that were not
tested, repeat step 2 for them.

In case of any problems, contact your network administrator to make sure that the network is IP
multicast enabled.

To prepare the cluster:
1. Prepare the database system as explained in section Database Server Preparation on page 19
2. Install WebLogic Application Server on all computers that you want to include in your cluster. Use

the WebLogic installation instructions and the special instructions for configuring WebLogic in
section How to configure a WebLogic Domain for the Interstage BPM Server on page 21.

3. On the computer you have selected for your WebLogic Administration Server, perform the following
substeps:
a) Start the WebLogic Administration Server as instructed in section Starting WebLogic

Administration Server on page 23.
b) Install and deploy Interstage BPM Server. Use the instructions in chapter Installing and

Deploying Interstage BPM Server and Console on page 25.

Ensure you select to create the default tenant during deployment.Note:

Ensure you do not use 'localhost' but the machine name or IP address in all screens
during deployment.

Note:

This deployment is only a dummy deployment, that is done for generating all the necessary
files to be used for the cluster set-up.

Note:

During deployment, a properties file is generated that contains the server configuration
parameters. You will need to update and import the generated file in a later configuration step.

c) Make sure that Interstage BPM is operating correctly in a simple configuration i.e. running a
single Interstage BPM Server.

d) Stop the Interstage BPM Server.
e) Back up the config.xml file that contains the configuration for your installed Interstage BPM

Server by copying it to a directory where it remains unmodified during an installation.
The config.xml file that contains the configuration for your installed Interstage BPM Server
is located in the following directory:
• <BEA_HOME>/user_projects/domains/<Domain Name>/config for WebLogic 9.2
• <MW_HOME>/user_projects/domains/<Domain Name>/config for WebLogic 10.3.2

f) Undeploy the dummy Interstage BPM Server deployment. Refer Undeploying and Uninstalling
Interstage BPM Server and Console on page 67.

You are now ready to configure a WebLogic cluster.

F.1.2 Configuring Environment Variables
To configure the required environment variables:
1. Edit the environment variable script located in <Interstage BPM Server Installation

Directory>/server/deployment/WLS-Cluster:
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Environment Variable ScriptOperating System

setIBPMenv.cmdWindows

setIBPMenv.shUNIX

2. Provide the appropriate values for the following variables:

DescriptionEnvironment Variable

Location of your WebLogic installation directory.
Example on Windows:
• On WebLogic 9.2: C:\bea
• On WebLogic 10.3.2:

C:\Oracle\Middleware

Example on UNIX:
• On WebLogic 9.2: /opt/bea
• On WebLogic 10.3.2:

/opt/oracle/middleware

BEA_HOME=<WebLogic Installation
Directory>

Path of the WebLogic installation directory upto
the server folder.
Example on Windows:
• On WebLogic 9.2:

C:\bea\weblogic92\server

• On WebLogic 10.3.2:
C:\Oracle\Middleware\wlserver_10.3\server

Example on UNIX:
• On WebLogic 9.2:

/opt/bea/weblogic92/server

• On WebLogic 10.3.2:
/opt/oracle/middleware/wlserver_10.3/server

WEBLOGIC_SERVER_HOME=<WebLogic
Installation Directory upto 'server'
folder>

Name of the WebLogic domain that you created
for Interstage BPM.
Example: InterstageBPM_domain

weblogic_domain=<Domain Name>
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DescriptionEnvironment Variable

Location of the domain directory.
Example on Windows:
• On WebLogic 9.2: C:\bea\user_projects

\domains\InterstageBPM_domain

• On WebLogic 10.3.2:
C:\Oracle\Middleware
\user_projects\domains\InterstageBPM_domain

Example on UNIX:
• On WebLogic 9.2:

/opt/bea/user_projects/domains/InterstageBPM_domain

• On WebLogic 10.3.2:
/opt/oracle/middleware/user_projects/domains/InterstageBPM_domain

DOMAIN_DIR=<Domain Directory>

While editing the setIBPMenv script, ensure you use only forward slashes (/) with any paths
in the script.

Note:

F.1.3 Configuring the Cluster
All of the WebLogic configurations performed to configure a cluster are performed on the computer
you have selected for your WebLogic Administration Server. This is the computer upon which you
installed Interstage BPM for WebLogic as a single server and got it running. You must continue to
connect to this computer to make any configuration changes.
You configure the cluster by running a script. The script deploys the following components on the
cluster:
• JDBC
• Data Source
• JMS
• Interstage BPM Enterprise JavaBeans (EJBs)
• Startup Class
To configure an Interstage BPM Cluster on the WebLogic Administration Server computer:
1. Locate the following files in <Interstage BPM Server Installation

Directory>/server/deployment/WLS-Cluster:
• ibpmWLInstallScripts.properties

• ibpmWLInstallScripts.py

• On Windows: runWLScript.bat
• On UNIX: runWLScript.sh

2. If you want more than two servers in your Interstage BPM Cluster or want to change the names
of your servers or port numbers:
• Change the clusterServers parameter in the ibpmWLInstallScripts.py script.
• Change the NoOfServerInCluster parameter in the ibpmWLInstallScripts.properties

properties file as appropriate.
Make sure that the server names and port numbers are unique.
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Example:
To add a server called InterstageBPMCS3 with port 49959 to the cluster configuration, change
the clusterServers parameter in the ibpmWLInstallScripts.py properties file to the following:
clusterServers={'InterstageBPMCS1':49952,'InterstageBPMCS2':49956,'InterstageBPMCS3':49959}

Also, change the NoOfServerInCluster parameter in the ibpmWLInstallScripts.properties
properties file to the following:
NoOfServerInCluster=3

3. Run the cluster configuration script:

Cluster Configuration ScriptOperating System

runWLScript.bat <WebLogic Administrator Name> <WebLogic
Administrator Password> <Database User Name> <Database
User Password>

Windows

runWLScript.sh <WebLogic Administrator Name> <WebLogic
Administrator Password> <Database User Name> <Database
User Password>

UNIX

For <WebLogic Administrator Name> <WebLogic Administrator Password>, specify the
user account of the administrator for the WebLogic Administration Server.
For <Database User Name> <Database User Password>, specify the database user account
that you defined during deployment of the Interstage BPM Server.
Running this script configures the cluster. It modifies the EJBs, JMS, database connections, etc.
to a cluster configuration.
If you did not modify the cluster setup files according to step 2 of this procedure, you now have
a cluster called InterstageBPMCluster and two WebLogic Managed Servers. The primary server
is named InterstageBPMCS1. Its port is 49952. The secondary server is named
InterstageBPMCS2. Its port is 49956.

4. Verify that the application server has been configured correctly. To do so:
a) Log in to the WebLogic Administration Console using the following URL:

http://<hostname>:7001/console

b) Go to <Domain> > Environment > Servers and verify that the servers have been created.
If you did not modify the cluster setup files, the primary server is named InterstageBPMCS1
and uses port 49952. The secondary server is named InterstageBPMCS2. Its port is 49956.

c) Go to <Domain> > Deployments and verify that an application called
InterstageBPMCServerApplication has been installed.

F.1.4 Configuring the Shared Resource Root
The ResourceRoot is a directory on a central server containing resources (such as workflow
applications, file listeners, shared classes, and so on).
In a load-balancing system, the ResourceRoot directory must be located on a central server that can
be accessed by all server nodes; all server nodes must use the same ResourceRoot directory.
Each server node must be configured to access the ResourceRoot directory on that central server.
The server nodes are allowed to map those directories to different physical paths as long as they
use the same symbolic name for the directory.
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To configure your ResourceRoot:
1. On a central server, create a ResourceRoot directory. Make sure that all server nodes have read

and write access to this directory.
Example: In the sample system, a file server is used to host the ResourceRoot directory. You
could create a directory named InterstageBPMShared.

2. Create the tenants/Default/ folders under the ResourceRoot directory.
For example, //MyFileServer/InterstageBPMShared/tenants/Default/

3. Do the following:
a) From the Weblogic Administration Server computer's <Interstage BPM Installation

Directory>/server/instance/default/tenants/Default/ directory, move the following
folders to the tenants/Default/ folder under the ResourceRoot directory.
• apps

• attachments

• classes

• dmsroot

• lib

b) Copy the entire Interstage BPM structure from the Weblogic Administration Server computer
to the other computers in your cluster.
Example on Windows: If you accepted the default Interstage BPM location
C:\Fujitsu\InterstageBPM during installation, you would copy the Fujitsu directory and
all of its subdirectories from the WebLogic Administration Server computer svmd2 to the C:
drive of svmdapp5.
Example on Solaris: If you accepted the default Interstage BPM location /opt/FJSVibpm
during installation, you would copy the FJSVibpm directory and all of its subdirectories from
the WebLogic Administration Server computer svmd2 to the /opt directory of svmdapp5.
Example on Linux: If you accepted the default Interstage BPM location /opt/FJSVibpm
during installation, you would copy the FJSVibpm directory and all of its subdirectories from
the WebLogic Administration Server computer svmd2 to the /opt directory of svmdapp5.

The path of the Interstage BPM Server installation directory must be the same on all
computers in your cluster.

Note:

4. On Windows, on each server node, update the <Path> tag of DmsCollections.xml file located
in <Interstage BPM Server Installation
Directory>/server/instance/default/tenants/Default/resources to specify the
attachments directory on the file server.
Specify the path for the DMS root directory to be a folder different from the default IBPM installation
directory and add share permissions to that folder.
Use one of the following formats to specify the directory's path:
//<Remote Computer Name>/<Absolute Path of DMS Folder>/

\\<Remote Computer Name>\<Absolute Path of DMS Folder>\

Example:

<DmsCollections>
<Dms>
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<Path>//MyFileServer/InterstageBPMShared/tenants/Default/attachments</Path>

<ImplementationClass>com.fujitsu.iflow.dmsadapter.impl.FileSystemDmsSessionImpl

</ImplementationClass>
<Name>Attachments</Name>
</Dms>
</DmsCollections>

Note: • Do not use a network drive in the path specification. (For example, like in
<Path>P:\InterstageBPMShared\tenants\Default\attachments</Path>). Network
drives cannot be accessed by the Interstage BPM Server.

• In the path specification, if using the machine name does not work use the machine IP.

To use WebDAV directory as DMS, ensure that at least one File DMS directory (local path
folder) is present as the first DMS path in DmsCollections.xml.

Note:

5. Perform the subsequent steps if you are installing on the following operating system:
• UNIX
a) On each server node, mount the attachments directory that you copied on the file server.
b) On each server node, update the DmsCollections.xml file located in <Interstage BPM

Server Installation
Directory>/server/instance/default/tenants/Default/resources to specify the
attachments directory on the file server.

Example: If you mount the shared directory at mp1, you would update the DmsCollections.xml
file to look like the following:

<DmsCollections>
<Dms>
<Path>/mp1/attachments</Path>

<ImplementationClass>com.fujitsu.iflow.dmsadapter.impl.FileSystemDmsSessionImpl

</ImplementationClass>
<Name>Attachments</Name>

</Dms>
</DmsCollections>

To use WebDAV directory as DMS, ensure that at least one File DMS directory (local path
folder) is present as the first DMS path in DmsCollections.xml.

Note:
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The DMS root directory's mount point may be different on the individual server nodes. However,
the directory's symbolic name, which is specified in the <Name> element, must be the same on
all server nodes. The following figure shows this configuration:

Figure 31: Sample DMS Configuration

F.1.5 Updating the Interstage BPM Server Configuration Files
When you are running Interstage BPM Servers in a cluster, you must change some server
configuration settings to complete the cluster's server configuration.
To update the Interstage BPM Server configuration files:
1. On each of the cluster nodes, from the database, export system level server configuration

parameters into a configuration file (<filename>.properties).

Configuration Import ScriptOperating System

exportProperties.bat <filePath> <Database User Name>
<Password>

Windows

exportProperties.sh <filePath> <Database User Name>
<Password>

UNIX

Before you make any changes to the configuration file, create a copy of the configuration
file you exported as a back-up. In case you make errors while editing parameters and import
the file, Interstage BPM Server may not be able to start or errors may occur at runtime. In
such a case you can use the back-up file which contains a working configuration.

Note:

2. Add the following entries to the configuration file:

ServerName=<Name of the Cluster Server>
ServerSharedRoot=<Path of shared ResourceRoot in file server>

Example:
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These are the entries on svmd2:

ServerName=InterstageBPMCS1
ServerSharedRoot=//MyFileServer/InterstageBPMShared/

Make sure that you specify the server names defined in the WLInstallScripts.py script
located in <Interstage BPM Server Installation
Directory>/server/deployment/WLS-Cluster.

Note:

3. On any one of the cluster nodes, add the following to the configuration file:

ServerInCluster=true

4. Check the default settings for the multicast group.
A multicast group is used to distribute information among the Interstage BPM Servers in a cluster.
These are the default settings used by the Interstage BPM Servers:
• Multicast port number: 5000
• Multicast group address: 225.4.5.6

A multicast group address is an IP address in the range 224.0.0.0 to 239.255.255.255, inclusive.
It is used to identify the members of a multicast group. Each member of the group uses the
same multicast group address. The address 224.0.0.0 is reserved and must not be used.

If you want to change the default settings, add the relevant parameters to the configuration file

ClusterMulticastPort=<Multicast Port Number>
ClusterMulticastTopic=<Multicast Group Address>

If already present in the configuration file, ensure these parameters are not empty.Note:

As the multicast parameters are identical for all cluster servers, you only need to add them
to the configuration file on one of the cluster nodes.

Note:

5. On each cluster node, ensure the values of the following node-specific properties are correct:
• JMSNamingProviderURL

• KPIListenerConfigFile

• ServerBaseURL

• ServerEmailBaseURL

• ServerHost

• ServerName

• ServerRoot

6. Before importing the configuration file to the database, delete the older system properties from
the database (from the IBPMProperties table) using the following SQL command:

DELETE FROM IBPMProperties WHERE tenantId = -1 AND modifier = 0

In order for your changes to take effect, you will later import the updated configuration files into the
database.
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F.1.6 Updating the Interstage BPM Client Configuration
Interstage BPM Server comes with a client configuration file, which is used by Interstage BPM Clients
to connect to the server. You need to update the client configuration file so that the client connects
to one of the cluster servers.
To update the client configuration:
• On all computers in your cluster, update the following properties in the configuration file

iFlowClient.properties located in <Interstage BPM Server Installation
Directory>/client:
• JmsNamingProviderUrl

• NamingProviderUrl

Example:
These are the entries on svmd2:

JmsNamingProviderUrl=t3://svmd2:49952
NamingProviderUrl=t3://svmd2:49952

These are the entries on svmdapp5:

JmsNamingProviderUrl=t3://svmdapp5:49956
NamingProviderUrl=t3://svmdapp5:49956

F.1.7 Updating Environment Variables and Server Startup Scripts
Scripts that start Interstage BPM Servers in single-server mode are currently on all of your cluster
computers. You must modify some environment variables to start the cluster servers instead of the
default Interstage BPM Server. Also, you must check whether the server startup scripts match the
host's environment.
To update environment variables and server startup scripts:
1. On the WebLogic Administration Server, change the SERVERNAME parameter to the name of the

primary server in the environment variable script.

Environment Variable ScriptOperating System

setIBPMenv.cmdWindows

setIBPMenv.shSolaris
Linux

The script is located in <Interstage BPM Server Installation
Directory>/server/deployment/WLS-Cluster.
Example:
This is the entry before the change: SERVERNAME=<Server Name Provided During Deployment>

This is the entry after the change: SERVERNAME=InterstageBPMCS1

The server names to be used in a cluster are defined in the ibpmWLInstallScripts.py
script located in <Interstage BPM Server Installation
Directory>/server/deployment/WLS-Cluster.

Note:
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2. On all other computers in the cluster, perform these steps:
a) Update the SERVERNAME and SERVER_HOST_NAME entries in the environment variable script.

Environment Variable ScriptOperating System

setIBPMenv.cmdWindows

setIBPMenv.shUNIX

Example:
These are the entries on svmdapp5 before the change:
SERVERNAME=InterstageBPMServer

SERVER_HOST_NAME= svmd2

These are the entries after the change:
SERVERNAME=InterstageBPMCS2

SERVER_HOST_NAME=svmdapp5

b) Make sure that the JDBCPATH entry in the environment variable script is correct.
JDBCPATH specifies the path to the JDBC driver of the database you are using. The JDBC
driver must be copied from your database installation to a local directory on your computer.
For more information on the names of the JDBC driver files, refer to section Database Server
Preparation on page 19.

While editing the setIBPMenv script, ensure you use only forward slashes (/) with any paths
in the script.

Note:

3. On the WebLogic Administration Server and on all other computers in the cluster, make sure that
the paths specified in the server startup script and in the server shutdown scripts are correct.

Server Startup/Shutdown ScriptsOperating System

iFlowServer_Managed.bat

StopiFlowServer_Managed.bat

Windows

iFlowServer_Managed.sh

StopiFlowServer_Managed.sh

UNIX

The scripts are located in <Interstage BPM Server Installation
Directory>/server/deployment/WLS-Cluster.
Especially, verify the path to weblogic.jar and weblogic_sp.jar and the path to WebLogic's
server/bin directory.

F.1.8 Importing the Interstage BPM Server Configuration Files
Prerequisites:
• On one of the cluster nodes, you have updated the server configuration file as instructed in section

Updating the Interstage BPM Server Configuration Files on page 109.
• On each cluster node, you have updated the environment variables as explained in section

Updating Environment Variables and Server Startup Scripts on page 111.
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• The database server is running.

To import the system configuration files into the database:
• On the node on which you updated the configuration file in section Updating the Interstage BPM

Server Configuration Files on page 109, run the configuration import script located in <Interstage
BPM Server Installation Directory>/server/deployment/WLS-Cluster:

Configuration Import ScriptOperating System

importProperties.bat <filePath> <Database User Name>
<Password>

Windows

importProperties.sh <filePath> <Database User Name>
<Password>

UNIX

For <Database User Name> and <Password>, specify the database user account that you defined
during deployment of the Interstage BPM Server. <filePath> is the fully qualified file path of the
configuration file you updated.

The script imports the configuration file you updated in section Updating the Interstage BPM Server
Configuration Files on page 109 into the database.
After import is complete, for security reasons, delete the configuration file on each node.

F.1.9 Starting the Cluster
Prerequisite: The Interstage BPM Cluster must be completely configured by following the clustering
appendix instructions through section Updating the Interstage BPM Client Configuration on page
111.

To start the Interstage BPM cluster:
1. Make sure that the WebLogic Administration Server is started by checking to see that its Console

Window is open and that the output <Server started in RUNNING mode> is displayed.
If it is not started, you can start it in either of the following ways:
• Run the startup script provided by Interstage BPM in the <Interstage BPM Server

Installation Directory>/server/deployment/WLS-Cluster directory:

Startup ScriptOperating System

startWebLogic.batWindows

startWebLogic.shUNIX

• Run the startup script provided by Weblogic. For details, refer to section Starting WebLogic
Administration Server on page 23.

2. On all cluster computers, start the Interstage BPM Server using the startup script provided by
Interstage BPM.
This ensures that required environment variables are set before actually starting the server.
The startup script is located in <Interstage BPM Server Installation
Directory>/server/deployment/WLS-Cluster.
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Server Startup ScriptOperating System

iFlowServer_Managed.bat <WebLogic Administrator Name>
<WebLogic Administrator Password>

Windows

iFlowServer_Managed.sh <WebLogic Administrator Name>
<WebLogic Administrator Password>

UNIX

You can start the cluster servers in any order.
If you are following the example, run the server startup script on svmd2 and svmdapp5.
Upon successful initialization of the server, the following output is displayed:

...
<Joining cluster InterstageBPMCluster on ...>
...
<Server started in RUNNING mode>

F.1.10 Automated Failover Settings
During operation, events are created and written to the database by each server node. Events are
tied to the server node that created them and will be processed by this server node. If a server node
goes down, and no failover is used, remaining events tied to this node will not be processed, and
the processing of such events will resume only when the server node is available again.
Automated failover (which is enabled by default) ensures that events that cannot be processed are
automatically transferred to other server nodes in the load-balancing system. Automated failover
settings are controlled using the following server properties:
• The ClusterAutomateFailoverEnabled server property. By default, this is true, which enables

automated failover.
• The ClusterHeartbeatInterval property (which specifies how often the status of all nodes will

be checked) and the ClusterInterceptEvents property (which specifies, in case a node fails,
how many of it unhandled events will be handled by the active nodes at a time).

For details about these properties and how to change them, refer the Interstage BPM Server
Administration Guide.

If the ClusterAutomateFailoverEnabled server property is set to 'true' before you start
all nodes in a cluster, the following behavior may occur (depending on the value of the
ClusterHeartbeatInterval property, and how long start-up of each node takes):
As you start nodes, each started node may begin handling any unhandled events of the
remaining, to-be-started nodes; this 'failover' will continue until all nodes have been started.
This is normal and expected behavior.

Note:

During failover, the order of transfer of unhandled events is as follows: first history events,
then timer events, and then events of process scheduler.

Note:

Example
This example demonstrates the processing of events in case one of two server nodes fails.
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A sample load-balancing system with two server nodes has been set up. While all of the server nodes
are up and running, events are created and written to the database by each server node.

Figure 32: All Server Nodes are Up and Running

If Node A goes down, events remain assigned to that node and are waiting to be processed.

Figure 33: Server Node Goes Down
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If Node A goes down when automated failover is enabled:
• A pre-defined number (defined by the ClusterInterceptEvents server property) of node A's

unhandled events are transferred to Node B, and then processed by Node B.
• Then, depending on the value of ClusterHeartbeatInterval property, the next node status

check will be carried out.
• If node A is still found to be down, the next set from Node A's remaining events are transferred

to and processed by Node B.
If node A continues to be down, the process described above continues until all of Node A's unhandled
events (one set at a time) have been transferred to and processed by Node B.

Figure 34: Events are Transferred to Another Node

F.1.11 Running Two Cluster Servers on the Same Computer (Optional)
Prerequisite: The database server is running.

To configure two cluster servers running on the same computer:
1. Prepare and configure the cluster as instructed in sections Preparing the Cluster on page 102 and

Configuring the Cluster on page 105.
2. Make a copy of the directory <Interstage BPM Server Installation

Directory>/server/deployment/WLS-Cluster and place the copy under <Interstage BPM
Server Installation Directory>/server/deployment.
For the directory name, you are recommended to append the name of the cluster server that you
want to run from this computer, for example WLS-ClusterInterstageBPMCS1.
However, you can choose any other name.

3. From the database, export out the server configuration settings into a configuration file. Name
the configuration file ibpm.properties, and place the configuration file for that node at
<Interstage BPM Server Installation Directory>/server/instance/default.
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Refer to section Using the Configuration Export and Import Scripts on page 83 for details on how
to use the export script.

4. Copy ibpm.properties from <Interstage BPM Server Installation
Directory>/server/instance/default to the subdirectory that you just created, for example
to <Interstage BPM Server Installation
Directory>/server/deployment/WLS-ClusterInterstageBPMCS1.

5. In the subdirectory that you created, update ibpm.properties according to the instructions in
section Updating the Interstage BPM Server Configuration Files on page 109.

6. In the environment variable script, change the SERVERNAME parameter to the server's name in the
cluster.
The script is located in the subdirectory that you created, for example in <Interstage BPM
Server Installation Directory>/server/deployment/WLS-ClusterInterstageBPMCS1:

Environment Variable ScriptOperating System

setIBPMenv.cmdWindows

setIBPMenv.shUNIX

Example:
This is the entry before the change: set SERVERNAME=<Server Name Provided During
Deployment>

This is the entry after the change: set SERVERNAME=InterstageBPMCS1

The server names to be used in a cluster are defined in the ibpmWLInstallScripts.py
script located in <Interstage BPM Server Installation
Directory>/server/deployment/WLS-Cluster.

Note:

While editing the setIBPMenv script, ensure you use only forward slashes (/) with any paths
in the script.

Note:

7. Update the configuration import script. To do so:
a) Open the script from the subdirectory that you created, for example from <Interstage BPM

Server Installation Directory>/server/deployment/WLS-ClusterInterstageBPMCS1:

Configuration Import ScriptOperating System

importProperties.bat <FileName>
<UserName> <Password>

Windows

importProperties.sh <FileName>
<UserName> <Password>

UNIX

b) Replace ../../instance/default/ibpm.properties with ./ibpm.properties.
The script now references the ibpm.properties file that you copied to the subdirectory.

8. Run the configuration import script.
For security reasons, after importing the configuration file (ibpm.properties), ensure you delete
it.
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9. Start the Interstage BPM Server by running the startup script from the subdirectory that you
created, for example from <Interstage BPM Server Installation
Directory>/server/deployment/WLS-ClusterInterstageBPMCS1:

Server Startup ScriptOperating System

iFlowServer_Managed.bat <WebLogic Administrator Name>
<WebLogic Administrator Password>

Windows

iFlowServer_Managed.sh <WebLogic Administrator Name>
<WebLogic Administrator Password>

UNIX

10. Repeat steps 2 through 9 for each cluster server that you want to add.
If you are following the example, repeat these steps to configure a second cluster server called
InterstageBPMCS2.

F.1.12 Removing an Interstage BPM Cluster
To remove an Interstage BPM Cluster:
1. Log out of all Interstage BPM Clients and close all Browser windows.
2. In the ibpmWLInstallScripts.properties file located in <Interstage BPM Server

Installation Directory>/server/deployment/WLS-Cluster, change the opType setting to
the following:
opType=uninstall_cluster_ibpm

3. Run the cluster configuration script:

Cluster Configuration ScriptOperating System

runWLScript.bat <WebLogic Administrator Name> <WebLogic
Administrator Password> <Database User Name> <Database
User Password>

Windows

runWLScript.sh <WebLogic Administrator Name> <WebLogic
Administrator Password> <Database User Name> <Database
User Password>

UNIX

Running this script removes the Interstage BPM cluster from the application server.

The single-server installation of Interstage BPM is not modified by this procedure. If you want to
remove the single-server installation from the application server and uninstall the server software,
follow the steps explained in chapter Undeploying and Uninstalling Interstage BPM Server and
Console on page 67.
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Appendix G: Enabling NTLM Authentication Protocol for
Interstage BPM Console

Prerequisites: Interstage BPM Server and Console have been installed and deployed.

If accessing Interstage BPM Console on Windows, you can enable NTLMV1 (NT LAN Manager V1)
authentication protocol for Interstage BPM Console. Doing so allows Integrated Windows
Authentication for Interstage BPM Console users in a Microsoft AD network. For instance, if NTLM
has been enabled for a tenant of Interstage BPM Console, if any user under that tenant successfully
logs on to her Windows desktop, on accessing any Interstage BPM Console URL, she will be
automatically logged in to Interstage BPM Console without having to login to it explicitly; the Interstage
BPM Console login screen will not appear.

Note: • NTLM cannot be enabled for super users accessing the Interstage BPM Tenant
Management Console.

• NTLM authentication will only work if the machine on which Interstage BPM is being
accessed is on Microsoft AD network.

• Only NTLMV1 is supported. NTLMV2 is not supported.
• If NTLM is enabled:

• Access to Interstage BPM Console from a browser in remote desktop is not supported.
• Access to Interstage BPM Console from a browser in other remote-access clients is

not supported.

To enable NTLM for Interstage BPM Console:
1. Navigate to <Interstage BPM Console Deployment Directory>/WEB_INF/conf/ and add the

following parameters (and their values) to console.conf:
• SSOToken=<value> -this will be a single entry for all tenants. The value will be used to

authenticate the logged in user.
• SSOADIP.<Tenant-Name>=<value> -the value will be a tenant-specific IP address of the domain

controller (AD Server). Repeat this parameter for each tenant for which you want to enable
NTLM.

• SSODomain.<Tenant-Name>=<value> -the value will be the tenant-specific Domain Name
(NETBIOS Name). Repeat this parameter for each tenant for which you want to enable NTLM.

For details about the Interstage BPM Console configuration file (console.conf) refer the Interstage
BPM Console Online Help.

2. Update the following Interstage BPM Server configuration parameters:
• For system-level, update SSOToken=<value>. Its value will be used to the verify connection

between Console and Server using SSO. Ensure that the value is the same as that updated
in console.conf in the step above.

• For each tenant for which you want to enable NTLM, update
IASSSOLoginConfFileEntryName=com.fujitsu.iflow.sso. Its value specifies that Interstage
BPM will use Windows authentication for that tenant.

For details of how to update Interstage BPM Server system and tenant parameters, refer the
Interstage BPM Server Administration Guide.

3. Re-start Interstage BPM Server and Console.
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Appendix H: Troubleshooting
H.1 Log File Information

For details about Log Files, refer the Configuring Log Files topic in the Interstage BPM Server
Administration Guide.

H.2 Resolving Specific Error Situations

H.2.1 Interstage BPM Server Fails to Start
Check the Error.log file in the <Interstage BPM Server Installation
Directory>/server/instance/default/logs directory.

What to doLook for

Check if the database is running. Also check that
you can access the database from the machine
where the Interstage BPM Server is installed in
case the database is running on a different
machine. You can use telnet <Database
Server Hostname> <Port> from the server host
machine to check that the connection to the
database host/port can be established.

DbService : setConnection: Connection to
database server failed. Is the database
server running and reachable through the
network? {ORA-01089: immediate shutdown
in progress - no operations are
permitted.

Ensure that the user name/password as specified
in the LDAPAccessUserID /
LDAPAccessUserPassword parameters of the
Interstage BPM Server are correct and you can
login to your Directory Server using the above
user name/password.

LdapBroker : getContext: Could not create
the directory services. {[LDAP: error
code 49 - Invalid Credentials]}

LdapBroker : getGroupMembersByDN: Could
not retrieve the user groups. {Could not
create the directory services. {[LDAP:
error code 49 - Invalid Credentials]}}

LdapBroker : Could not retrieve the user
groups. {Could not create the directory
services. {[LDAP: error code 49 - Invalid
Credentials]}}

Ensure that the LDAP Server is running on the
port as specified in the LDAPServer parameter
of the Interstage BPM Server. You can use
telnet ldapServerHostName port from the
server host machine to check that the connection
to the host/port can be established.

getContext: Could not create the
directory services.

LdapBroker : getGroupMembersByDN: Could
not retrieve the user groups. {Could not
create the directory services.

LdapBroker : Could not retrieve the user
groups. {Could not create the directory
services.
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What to doLook for

This is because you installed WebSphere
Application Server in a Cell (deployment manager
and a managed node) environment, causing the
BOOTSTRAP_ADDRESS port to be incorrect in some
configuration files.
1. Get the correct value of the

BOOTSTRAP_ADDRESS port from the WebSphere
Application Server Console (from Servers >
Application Servers > <ServerName> >
Ports).
(For WebSphere 7.0, this path is Servers >
Server Types > WebSphere Application
Servers > <ServerName> > Ports)

2. Update the value of the BOOTSTRAP_ADDRESS
port for the following entries in the
iflowClient.properties file, as well as
Interstage BPM properties in the database.
(For steps to change the server properties,
refer the Interstage BPMServer Administration
Guide.)

• JMSNamingProviderURL (in the format
iiop://<Host Name>:<BOOSTRAP_ADDRESS>)

• NamingProviderURL (in the format
iiop://<Host Name>:<BOOSTRAP_ADDRESS>)

IflowStartup : @(Failed to execute the
IBPM startup routine task)Unable to
deliver the message for the requested
eventClass.
{javax.naming.ServiceUnavailableException:
A communication failure occurred while
attempting to obtain an initial context
with the provider URL:
"iiop://<ServerName>:<Ports>". Make sure
that any bootstrap address information
in the URL is correct and that the target
name server is running. A bootstrap
address with no port specification
defaults to port 2809. Possible causes
other than an incorrect bootstrap address
or unavailable name server include the
network environment and workstation
network configuration.}

H.2.2 Error in Trace.log
Check the Trace.log in the <Interstage BPM Server Installation
Directory>/server/instance/default/logs directory.

What to doLook for

Possible cause of this error: A user has been
deleted from the Directory Server (LDAP Server)
but the reference of it is still there in one of the
groups.

getGroupMembersByDN: Could not retrieve
the user groups. {[LDAP: error code 32
- No Such Object]}

H.2.3 Timeout During JavaScript Execution
When executing large JavaScripts, the current transaction timeout (120 seconds) is insufficient for
the following application servers:
• WebLogic Application Server
Due to this setting, script execution may fail with a "transaction timeout".
Your application server administrator can increase the transaction timeout depending on your usage
requirements, for example, to 200 seconds. This setting can be changed in the following location:
• WebLogic Application Server 9.2:
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<BEA_HOME>/user_projects/domains/<Domain
Name>/config/config.xml/<jta>/<timeout-seconds>

• WebLogic Application Server 10.3.2:
<MW_HOME>/user_projects/domains/<Domain
Name>/config/config.xml/<jta>/<timeout-seconds>

H.2.4 Failure in Writing to an Oracle Database
When the updating of an Oracle database table fails, for example, when you try to archive a process
instance, check the Oracle alert log file located in the <Oracle Installation Dir>/admin/<DB
instance name>/bdump directory, for example:
C:\ProgramFiles\Oracle\admin\orcl\bdump\alert_orcl.log

The following error may be observed:
{Database add/create request failed. {ORA-08103: object no longer exists}}

This failure may be due to the fact that the Datafile size reached the file size limit on the hard disk
of the database server.
The system administrator of the database server needs to increase the file size on the database
server hard disk.

H.3 Errors During Installation
This section lists several errors that could occur during the installation of Interstage BPM and describes
the required action(s) to take:

Installation of IBPM fails when trying to install a new build

The build directory of the existing installed build was deleted, without un-installing
the build or un-installation failed.

CauseI
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For Windows
Manually delete the earlier build's registry-entry, as follows:
1. Go to Start > Run, type regedit, click OK.
2. In the Registry Editor screen, go to HKEY_LOCAL_MACHINE > SOFTWARE

> Fujitsu > Install > Interstage BPM Server .

3. Delete the Interstage BPM Server registry entry under Install key.
4. Go to HKEY_LOCAL_MACHINE > SOFTWARE > Microsoft > Windows >

CurrentVersion > Uninstall >Interstage Business Process Manager xx.x.

5. Delete the Interstage Business Process Manager xx.x registry entry under
Uninstall key. This will ensure complete deletion of the registry entry for Windows
platform.

For Solaris
Manually delete the Solaris package information, as follows:
1. Open the Command Prompt window and run the command pkginfo -l FJSVibpm

from any location of the Solaris machine, to check if the Solaris package
information still exists.

2. If the Solaris package information is displayed, then delete the package information
using the following steps:
a. Create a file named ibpm.uninst under the /tmp location.
b. Run the command pkgrm FJSVibpm to delete the Solaris package.
c. Run the command pkginfo -l FJSVibpm once more, to ensure that the

Solaris package has been deleted successfully. If no information is displayed,
then it confirms that the Solaris package has been completely deleted from
the Solaris platform.

For Linux
Manually delete the RPM package information, as follows:
1. Open the Command Prompt window and run the command rpm -qi FJSVibpm

from any location of the Linux machine, to check if the RPM package still exists.
2. If the RPM package information is displayed, then delete the package information

using the command rpm -e FJSVibpm.
3. Run the command rpm -qi FJSVibpm once more to ensure that the RPM package

has been deleted successfully. If no information is displayed, then it confirms that
the RPM package has been completely deleted from the Linux platform.

Action

The Interstage BPM installation program was unable to launch on Linux

It is possible that some essential packages may not be installed on the Linux machine.CauseI

For details about mandatory packages for Linux, refer to section Preparation for
Installing Interstage BPM on Linux Environments of the Interstage BPM Server and
Console Installation Guide. After installing mandatory packages, retry launching the
Interstage BPM installation program for Linux.

Action
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H.4 Errors during Deployment of the Interstage BPM Server
If you have trouble executing the Deployment Tool, you can check the cause of error by viewing
deployment.log. The deployment log is created at the following location:
On Windows: <Interstage BPM Installation
Directory>\server\deployment\logs\deployment.log

On Unix: <Interstage BPM Installation
Directory>/server/deployment/logs/deployment.log

The following tables explain the possible causes of errors during server startup and the appropriate
action(s) to take:

An error occurred during Interstage BPM database creation/update

One of the following values provided during deployment were wrong:
• Database Administrator user name
• Database Administrator password

CauseI

Restore the database from the backup of the database made before deploying
Interstage BPM.
Run the Deployment Tool again and select Use existing database in the Database
Settings screen. In this way, the database is configured without data deletion from
the database.

Action

One of the following values provided during deployment were wrong:
• Host name of the database server
• Database SID (database instance name)
• Database port

CauseII

Restore the database from the backup of the database made before deploying
Interstage BPM.
Remove Interstage BPM from the application server and deploy it again using the
Deployment Tool.

Action

Database server is not running.CauseIII

Start the database server.
Run the Deployment Tool again and select Use existing database in the Database
Settings screen. In this way, the database is configured without data deletion from
the database.

Action

Errors caused by JDK Version

The version of JDK specified during installation does not match the version required
for this application server.

CauseI
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You need to re-install Interstage BPM. During re-installation, specify the JDK specific
to your Application Server.
Alternately, you can change the JAVA_HOME variable present in the deployment tool
startup script. For details, refer section Configuring the Deployment Tool Startup
JVM of the Interstage BPM Server and Console Installation Guide.
Supported JDK versions are listed in the Interstage BPM Server Release Notes.

Action

Undeployment Problems

If Server instance removal process can not advance beyond the Application Server
Configuration page, contents of the setupconfig.properties file are corrupted.

CauseI

Remove the setupconfig.properties file from the following directory:
• Windows: <Interstage BPM Installation

Directory>\server\deployment\resources

• UNIX: <Interstage BPM Installation
Directory>/server/deployment/resources

Then re-start the deployment tool. Note that after you remove this file, your
undeployment information is erased. Therefore you need to select the Application
Server from which you want to remove Interstage BPM again.

Action

Problems related to LDAP Server Access

Even if LDAP server is up, the error message Unable to connect to specified
directory server appears. This happens when Super user or Tenant Administrator
is not registered in LDAP server.

CauseI

Please register the Super user and Tenant Administrator in the LDAP server before
executing the Deployment Tool.

Action

Errors Pertaining to Active Directory

The Active Directory Server is remote and Active Directory is not running.CauseI

Start the Active Directory Server, and then start the Interstage BPM Server.Action

Interstage BPM cannot connect to the Active Directory Server because one of the
following values provided during deployment was wrong:
• Active Directory Key
• Active Directory Organizational Unit

CauseII

Remove Interstage BPM from the application server and deploy it again using the
Deployment Tool.

Action
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Errors Pertaining to Oracle Directory Server Enterprise Edition

Interstage BPM cannot connect to the LDAP Server because one of the following
values provided during deployment was wrong:
• LDAP Key
• LDAP Organizational Unit

CauseI

Remove Interstage BPM from the application server and deploy it again using the
Deployment Tool.

Action

H.5 Errors Related to InterstageBPMDatabaseCreation/Update

Errors Pertaining to the Database

The Database Server is not running.CauseI

Start the Database Server, and then start the Interstage BPM Server.Action

Errors Pertaining to a Hostname Change

You changed the hostname of the computer where Interstage BPM Server has been
installed. As the hostname occurs in the names and values of various configuration
parameters of the Interstage BPM Server, the server cannot access its configuration
settings.

CauseI

In the IBPMProperties table of the Interstage BPM database, make the following
changes:
• In the PROPERTYKEY column, update any parameter names that have the hostname

in the suffix.
These parameters have the format <PARAMETER_NAME>.<HOSTNAME> or
<PARAMETER_NAME>.<HOSTNAME>.<SERVERNAME>.

• In the PROPERTYVALUE column, update any parameter values containing the
hostname.

To update the IBPMProperties table, use the appropriate database commands or
a database client software.

Action

H.6 Contacting Your Local Fujitsu Support Organization
If you are unable to troubleshoot your problem:
1. Replicate the actions that caused the error.
2. Contact your local Fujitsu Support organization and provide the following information:

General Information
• Operating System
• Directory Service (type and version)
• Database server (type and version)
• JDK version
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• Application server (type and version)
• Interstage BPM edition, version and build number
• Major problem area
• Priority of the issue
• Environment in which the problem occurs
Configuration Information
• The configuration file that you exported from the Interstage BPM Server
Log Files
• All log files from <Interstage BPM Server Installation

Directory>/server/instance/default/logs

• Deployment log file from <Interstage BPM Server Installation
Directory>/server/deployment/logs/deployment.log

• When using WebLogic 9.2: All log files from <BEA_HOME>/user_projects/domain/<Your
Domain>/servers/AdminServer/logs

• When using WebLogic 10.3.2: All log files from <MW_HOME>/user_projects/domain/<Your
Domain>/servers/AdminServer/logs

OS System Logs
• The Windows event log that you obtain using the Windows Event Viewer
• Linux system logs stored in /var/log/messages

• Solaris system logs stored in /var/adm/messages

Problem Description
• Description of the steps you performed before the problem occurred
• Frequency with which the problem occurs
Problem Details
• The application program and its source code that caused the error
• The XPDL file of the process definition that caused the error
• Information about Java Actions, Timers and Agents defined in the process definition
• Screenshot of the process instance history if the process instance goes into error state
• Stack trace if any exception is displayed

You can obtain the stack trace by clicking Details on the error page displayed in the Interstage
BPM Console.

• Screenshot of the exception wherever it is displayed
• Screenshot of the process instance (graphical view) if the process instance goes into error

state or into an unexpected state
• Calendar files (*.cal) if timers are used
• The agentsConfig.xml file if agents are used
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